
2nd y-axis
An optional reference line marked at regular intervals with numeric values. In a vertical chart, the 2nd y-axis is on the 
right side of the chart. In a horizontal chart, the 2nd y-axis is at the top of the chart.
Use a second y-axis when you want to compare data series that require different scales.



3D effects
Visual characteristics for a 3D chart, including platform, rotation, and elevation. For 3D pie charts, you can change 
the lighting, elevation, depth, and shadow.



area chart
Area charts show trends in data over time. Like line charts, area charts emphasize trends and totals rather than 
individual values. For example, use an area chart to see trends in costs for training and salaries over a five-year 
period.



attributes
Visual characteristics of an object. Attributes determine the appearance of text, lines, and fill patterns. 
Text attributes include color, font, alignment, and numeric format.
Line attributes include color and line style.
Fill attributes include color and pattern.



axis labels
The labels used to identify the tick marks on an axis. Also called tick mark labels.



axis lines
Lines used to mark the location of axes. You can show or hide an axis line, as well as change its style.



axis titles
A line of text displayed below or beside an axis. The text of the axis title typically indicates the type of data plotted or 
describes the axis units.

 



axes
Lines that form a frame of reference for the chart data. Most charts have an x-axis and a y-axis. You can also add a 
2nd y-axis for charts that require two different scales. 

Pie charts do not have axes. Radar charts have a separate axis for each series.



axis subtitle
A second line of text displayed below or beside an axis title.

 



bar chart
Each data series is plotted as a bar or portion of a bar.
There are three categories of bar charts. Each one suits a different purpose:

Vertical bar charts 
Horizontal bar charts 
Stacked bar charts 



chart title
Text in a chart that describes the main idea illustrated by the chart. The chart title typically appears at the top of the 
chart.



chart
Graphic representation of data. A chart includes the parts illustrated below. Chart types include area, bar, high-low-
close-open (HLCO), line, mixed, pie, radar, and scatter (XY).



chart styles
Named and saved sets of chart attribute settings that you can apply to any number of charts of any type. You can use
chart styles to create a similar look for a set of charts. Chart styles specify all characteristics of a chart except its data 
and type.



collection
Two or more ranges, selected in a worksheet. The ranges in a collection can be contiguous or not and can span 
worksheets.



data points
Values plotted in a chart. In a bar chart, data points appear as bars; in a pie chart, as slices; in a scatter (XY) chart, 
as markers.



data range
Range of values that represent the series of a chart, for example, the lines or bars.



data table
Table containing the data used to create a chart. The data table appears below a chart instead of a legend. 
For a table of data without any graphical representation, use the number grid chart type.



chart data
Data used to create the individual data series or pie slices in a chart.



default chart style
Set of chart attributes that are automatically applied when you create a chart. You can create and save customized 
styles.



chart types
Includes area, bar, high-low-close-open (HLCO), line, mixed, pie, radar, scatter (XY), and number grids. 



grid lines
Horizontal and vertical lines that span the plot area from any axis beginning at the tick marks. 

• Major grid lines extend from the major tick marks. 
• Minor grid lines appear between the major grid lines and extend from the minor tick marks.

You can display grid lines with or without the corresponding tick marks.

 



horizontal bar charts
Used to compare values at a single point in time. For example, use a horizontal bar chart to show:

• The return on investment for ten mutual funds in 1994
• The number of cars sold by color in 1990



high-low-close-open (HLCO) charts
Used to track data that fluctuates over time. Also called "stock market charts," HLCO charts are good for monitoring 
stock prices, commodities, air temperature, and currency rates. Examples include: 

• The changes in a stock price over a 30-day period
• The daily temperature range in August for Juneau, Alaska



horizontal chart
Charts with a horizontal y-axis. In a horizontal chart, the usual orientation of the axes is rotated clockwise 90 degrees.



InfoBox
A modeless dialog box used to specify attributes and settings. 

• You can leave the InfoBox open when working with a chart.
• When you make a chart selection, the InfoBox displays the appropriate settings for that part.
• When you change a setting, the chart updates immediately. 
• For help on a panel, click the question mark in the upper corner of the InfoBox.



legend
A box containing symbols and text explaining what each data series represents. Each symbol is a color, pattern, or 
marker that corresponds to one data series in the chart.



legend label
Text that describes one item (a slice of a pie chart or a series of any other chart type) of a legend.



line chart
Traces the changes in sets of data over time. Each data point represents a value at a particular time period or 
moment in time. Each line represents a category of data. Line charts are often the best choice for time-series data, 
especially when you have a lot of data points.
For example, use a line chart to show:

• Daily sales over two months
• Average salaries for engineers compared to average salaries for other professionals, charted by age



link
A reference to data stored in a worksheet or file. You use a link to read data from a worksheet or file directly into your 
chart, without re-entering values when they change. Links will update the chart when the data changes. 



marker
Symbol representing each value in the data series for a line, mixed, and scatter (XY) chart. 
Use the Basics panel of the InfoBox to choose a different symbol for the marker. To display the marker, be sure the 
Marker box is checked. 



mixed charts
Chart created by combining parts from a line chart, bar chart, or area chart. You can plot data in two or three forms on
the same chart. In a mixed chart, each series can be shown by using lines, areas, or bars.
For example, use a mixed chart to show the relationship between revenues, expenses, and profits over a five-year 
period. You can plot profits and expenses as bars, and expenses as a line.



chart note
One to three lines of descriptive text you can add to a chart. You can use a note to describe or emphasize data in a 
chart.

 



number grids
A table of actual data values rather than a graphical representation. Number grids can show text values as well as 
numeric values. 



percent chart
Displays values in each data range as a percentage of the sum (100%) of all the values. Percent charts include pie 
charts and 100% stacked bar charts. 



pie slices
Wedges in a pie chart that represent each data value in the series shown by the pie chart. A pie chart can display up 
to 40 slices. A single slice can be used to represent a collection of all the small values. 



pie slice label
Labels that identify each slice in a pie chart. You can assign labels that are the actual values in the data series, the 
percentage of the whole that each slice represents, or descriptive text from the legend.



pie title
Descriptive text that explains the contents of a pie chart.



pie totals
The total value represented by the pie.



pie chart
Chart showing the relationship of parts to the whole. Each slice of the pie represents a data value. The size of the 
slice corresponds to the percentage of the total that it represents. 
A pie chart displays each series in a separate pie, with each value in the series representing a different slice.    Pie 
charts can display up to 40 slices per pie.
Use a pie chart when you want to compare five or six values in a single data series to the total. 
For example, use a pie chart to show:

• Sales of five different car models made in a given year



plot
Area bounded by the axes, where data is plotted on a chart. By default, the plot contains the bars, lines, or areas in a 
chart. You can change the color, fill pattern, and frame of a plot. 



range
A block of adjoining cells that can range in size from a single cell to an entire file. For example, B:A15..B:B17 is a 
range of 3 cells in column A and 3 cells in column B. A 3D range spans two or more worksheets; for example, 
A:A4..B:B8.



series
A set of values plotted on a chart. If you assign series by column, each column of data represents a series. If you 
assign series by rows, each row of data represents a series.
All chart types except pie charts can display up to 30 data series. Pie charts show one series in each pie.



series label
Labels that identify each value plotted in a series. You can assign labels that are the actual values in the data series, 
or the percentage of the whole that each value in a series represents. You can also enter text labels manually or 
retrieve them from a range in an external worksheet.

 



stack totals
The total value represented by the bars in a stacked bar chart.



stacked bar chart
Compares totals as well as individual values for different time periods or categories of data. Each bar in a stacked bar
chart represents a total. The segments in each bar represent the values that add up to the total.
For example, use a stacked bar chart to compare:

• The costs of salaries and benefits over five years
• Sales of three different products during four quarters



chart tables
A tabular display of chart values, in one of two formats:

• Number grids show values instead of a graphical representation of those values
• Data tables appear under a graphical chart to show the values represented on the chart



tick mark labels
Text that identifies values associated with an axis. The tick mark labels appear under or next to the major tick marks 
on an axis.
When creating a chart, you can specify the tick mark labels to appear on the x-axis (also called x-axis labels). The y-
axis labels are typically generated automatically from the data.
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trend line
A line associated with a series in a scatter (XY) chart that shows the general trend of the series. Also called a 
regression line.



vertical bar chart
Compares individual values. The height of each bar indicates the value at one point in time, and the left-to-right 
orientation of the chart provides a sense of movement over time. Vertical bar charts can also illustrate a frequency 
distribution.
For example, use a vertical bar chart to show:

• House sales from January to June (values at different points in time)
• Number of employees who fall within different age ranges (frequency distribution)



vertical chart
Y-axis and the 2nd y-axis (if any) are plotted vertically. Vertical display is the default for most charts.



with-depth effect
Creates the illusion of a third dimension in a chart. A "with-depth" chart looks three-dimensional, but cannot be 
manipulated. A 3D chart allows for changes to rotation and elevation. 



x-axis
A reference line marked in regular intervals with descriptive labels. In a scatter (XY) chart, the intervals on the x-axis 
represent numeric (scaled) values, not labels. Typically, the x-axis shows the categories of the data plotted, and the 
y-axis shows the data values.

 



scatter (XY) chart
Shows whether there is a correlation between large sets of data. If the data points cluster around an imaginary line, a 
correlation exists. The more points that approach the line, the stronger the correlation.
For example, use a scatter chart to determine the correlation between:

• Daily sales of frozen yogurt and the average daily temperature during July
• Personal income and years of education

 



y-axis
A reference line marked in regular intervals with numeric values. Typically, the y-axis shows the data values being 
plotted, and the x-axis shows the categories of the data.



z-axis
A reference line in a 3D chart that shows the values plotted for the third dimension.



Details: Rotating 3D charts
Options

• Rotation: Pivots around a point. You can specify a value from 5 to 85. 
• Elevation. Controls the apparent view angle. Enter a value from 5 to 85. The lower numbers show the chart at eye

level. As the number increases, the elevation shifts so that at 85 you see the chart as if you were looking down on
top of it. 

• Platform: Choose Low, Medium, or High if you want a platform. Choose None for no platform. 
• Lighting: Choose the direction of the light: From left or From right.

{button ,AL(`H_LC_3D_CHANGE_STEPS',1)} Go to procedure



Rotating 3D charts
You can rotate and maneuver any 3D chart. With-depth charts cannot be rotated.
1. Select a 3D chart.
2. Choose Chart - Plot.
3. Click the 3D tab.
4. Under Rotation, enter a value between 5 and 85.
5. Under Elevation, enter a value between 5 and 85. 
6. Under Platform, select a size, or choose None for no platform. 
7. Under Lighting, select the lighting direction. 

{button ,AL(`H_LC_3D_CHANGE_DETAILS',1)} See details
{button ,AL(`H_LC_3D_PIES_CHANGE_STEPS;H_LC_CHANGING_PLATFORM_STEPS;',0)} See related topics



Overview: Three-dimensional charts
You can create the illusion of a third dimension in a chart. A 3D chart allows for changes to rotation and elevation. A 
"with-depth" chart looks three-dimensional, but cannot be manipulated. 

Creating 3D and "with-depth" dimensional charts
Like other chart types, you can choose a 3D or "with-depth" chart at the time you create the chart, or modify an 
existing chart. Choose one of the types from the Type panel of the InfoBox. See Adding 3D to a chart . 

Modifying 3D effects
Use the InfoBox to change the dimensional effects of a 3D chart. See Changing 3D for area, bar, line, and mixed 
charts and Changing 3D for pie charts.
For bar, line, area, and mixed charts, you can change:

• Rotation, to change the perspective from which you view the chart.
• Lighting, to shift the apparent direction of the light source and which side is shaded.
• Elevation, to modify the tilt of the chart.
• Platform, to change the height of the area beneath the chart. See Changing the 3D platform.

For 3D pie charts, you can change lighting and elevation. In addition, you can change:
• Depth, to vary the percentage of space used by the 3D effect.
• Shadow, to alter the location of the shadow under the pie.

Note The data for a 3D chart is always two-dimensional. Using 3D changes only the appearance of the chart, not 
how the chart is generated.



Details: Changing 3D for pie charts
Options
You can change one or more options for the 3D effect: 

• 3D depth. Enter a value between 5 (flat) to 100 (cylindrical), or click the arrows to make incremental changes.
• Elevation. Enter a value between 5 (side view) and 85 (top-down view), or click the arrows to make incremental 

changes.
• Shadow depth. Choose from Shallow, Normal, Deep. To change the shadow depth, you must select    a shadow 

style other than None.
• Shadow style. Choose None, Down, Left, Right.

{button ,AL(`H_LC_3D_PIES_CHANGE_STEPS',1)} Go to procedure



Changing 3D for pie charts
You can change the three- dimensional effect for a 3D pie chart.
1. Select a 3D pie chart.
2. Choose Chart - Plot.
3. Click the 3D tab.
4. Under 3D depth, enter a value between 5 and 100.
5. Under Elevation, enter a value between 5 and 85.
6. Under Shadow depth, select the shadow depth.
7. Under Shadow style, select a shadow style, or None for no shadow.

{button ,AL(`H_LC_3D_PIES_CHANGE_DETAILS',1)} See details
{button ,AL(`H_LC_3D_CHANGE_STEPS;H_LC_ADDING_3D_STEPS;H_LC_CHANGING_PLATFORM_STEPS;',0)

} See related topics



Details: Adding 3D to a chart
After you select a chart type, such as Bar, Line, Area, or Pie, select a 3D or "with-depth" effect by clicking the 
appropriate icon.

To change the rotation or elevation, use the InfoBox. Under Properties for, choose Plot. Click the 3D tab and choose 
a different rotation and elevation. 

{button ,AL(`H_LC_ADDING_3D_STEPS',1)} Go to procedure



Adding 3D to a chart
You can add a three-dimensional look to any bar chart, line chart, area chart, mixed chart, or pie chart.
1. Select the chart you want to change.
2. Choose Chart - Chart Type. 
3. Under Chart type, select the type of chart. 
4. Click an icon (3D or with-depth) at the right side of the panel. See details .

{button ,AL(`H_LC_ADDING_3D_DETAILS',1)} See details
{button ,AL(`H_LC_3D_CHANGE_STEPS;H_LC_3D_PIES_CHANGE_STEPS;',0)} See related topics



Changing the 3D chart platform
You can change the appearance of a wall, face, or floor of a 3D platform.
1. Choose Chart - Plot.
2. Click the Lines & Colors tab.

3. Under Plot section, click the icon that corresponds to the platform area you want to change.
4. Under Interior, select a Pattern, Pattern color, and Background.
5. Under Line, select a Color, Width, and Style.
Tip To select with the mouse, move the cursor to the platform part you want to select, hold the CTRL key, and click the
part.

{button ,AL(`H_LC_3D_CHANGE_STEPS;',0)} See related topics



Pie charts: 3D depth
Changes the depth of the 3D effect in the pie chart.



Data: Assign series
You can assign series by column or by row.

Assigmen
t

Type of chart Description Example

By column All except pie 
charts

Plots each column of 
data in the selected 
range as a series

By column Pie charts Plots each value in the
selected column as a 
pie slice

By row All except pie 
charts

Plots each row of data 
in the selected range 
as a data series

By row Pie charts Plots each value in the
selected row as a pie 
slice



Axes: Axis intercept
Sets the location on the y-axis where you want the x-axis to cross. In a scatter chart, sets the location on the x-axis 
where you want the y-axis or second y-axis to cross.



Axis subtitle text: Based on scale
Displays a label that identifies the units for numbers greater than 1000 that are plotted on a numeric axis. 

Example
When numbers are in the thousands, the axis subtitle is "Thousands." The axis tick mark labels are units representing
thousands.



Tick mark labels: Overlapping labels
Changes the arrangement of the tick mark labels on a non-numeric axis.

• Automatic. Avoids overlapping the labels.
• Stagger. Displays the labels staggered on two lines.
• Slant. Displays the labels rotated at an angle.
• Vertical. Displays the labels rotated 90 degrees.



Tick mark labels: Show labels every nnn ticks
Determines how many tick mark labels are displayed. For example, to label every tick mark, enter 1. To label every 
other tick mark, enter 2.



Tick mark labels: Character limit
Determines how many characters are displayed for each tick mark label.    For example, to display only the first five 
characters for each label, enter 5.



Edit Data window
Use the Edit Data window to enter values, legend, titles, and labels.



3D: Elevation
Changes the angle of the chart elevation. Select an angle from 5 (eye-level) to 85 (looking down on the top of the 
chart.)



Pie charts: Explode slices %
Controls how far the pie slices are moved out from the center of a pie chart.
You can enter a value between 0 (slices are not exploded) and 100 (the pie slices are completely exploded.) 



Bars: Gap %
Controls the space between bars or clusters of bars in charts. Enter a value between 0% (no space between the 
series) and 100%, where the gap is equal to the width of the series.



3D: Lighting
Changes the apparent direction of the light source in 3D area, line, bar, and mixed charts.



Data: Format type
Changes how numbers are displayed. You can set up to 15 decimal places. Format types include:

• General. Uses standard number formats. Decimal places cannot be set.
• Currency. Provides several currency options.
• ISO currency.
• Comma. Adds commas as separators.
• Fixed. Lets you set fixed-width values.
• Scientific. Lets you set scientific notation.
• Percent. Lets you set the percent label.
• Date. Provides several date options.
• Time. Provides several time options.



Bars: Overlap %
Controls the amount of overlap of bars within the same cluster. Overlap is a percentage of the bar width. You can set 
the overlap for any value from 0 (no overlap) to 100 (overlap bars completely). 
The overlap % is available only for bars that are clustered or not stacked.



3D: Platform
Changes the height of the platform area beneath a 3D chart.



3D: Rotation
Rotates a 3D chart clockwise by degrees, changing the perspective from which you view the chart. Enter a value 
between 5 and 85.



Bars: Row gap%
Controls the space between rows of series in a 3D bar chart or a bar chart with depth.
You can specify a row gap between 0 (no gap between the series) and 100 (gap is equal to the width of the series). 



Trend lines: R-squared
A measure of the amount of variability in the data that is captured by the trend line. High values of R-squared indicate
that the trend line tracks the data closely.



Scale: Type
Sets the scale for the axis.

• Linear. Numbers increase or decrease by a fixed number of units for a fixed interval.
• Log. Numbers increase or decrease logarithmically. Numbers must be greater than zero (only positive numbers 

are displayed).
• 100%. Numbers range from 0 to 100% (a percent scale).



Scale: Direction
The direction settings for the axis scale are:

• Ascending. Displays values on the axis from lowest to highest.
• Descending. Displays values on the axis from highest to lowest.



Scale manually: Major ticks 
Sets the interval between major tick marks on an axis. To use the default setting, deselect the box.

Example
To display the major tick marks at intervals of 100, type 100 in the Major ticks box on the Scale panel of the InfoBox.
Note If major tick intervals do not divide evenly into the maximum value, the axis will rescale to the maximum value. 



Scale manually: Maximum
Sets the highest value for the axis scale. "Maximum" is set on the Scale panel of the InfoBox.
Note If major or minor intervals do not divide evenly into the maximum value, the axis will rescale to the maximum 
value. 



Scale manually: Minor ticks
Sets the interval between minor tick marks on an axis. Deselect the box to use the default setting. 

Example
To display the minor tick marks at intervals of 50, type 50 in the Minor ticks box on the Scale panel of the InfoBox.
Note    If minor intervals do not divide evenly into the maximum value, the axis will rescale to the maximum value. 



Scale manually: Minimum 
Sets the lowest value for the axis scale. Deselect the box to use the default setting. 



Scale: Units
Changes the unit scale for a numeric axis. The units are the measurements for tick mark labels on a numeric axis. 

• Auto. Automatically sets the tick mark labels on a numeric axis based on the numbers plotted in the chart.
• None. Displays the actual values as the tick mark labels.
• Thousands, Ten Thousands, Millions, ..., Thousandths, Millionths, .... Sets the scale according to the unit you 

select from the list.
• Other. Sets the scale to a power of 10 not listed. Enter a number for Units.

The Units box displays a number representing the power of 10 used for the unit scale you chose. For example, if you 
choose Thousands, the number 3 appears in the box.
Note If the axis Subtitle is set to Automatic, the subtitle text automatically displays the units you select.



Pie charts: Scaling options
You can change the scale of pies in a multiple pie chart.

• Equally. Each pie appears the same size, regardless of the total of each pie.
• Scale by area. Pies with larger totals appear larger.
• Scale by height. Pies with larger totals have taller platforms (3D multiple pies only).



Data labels: Position
You can specify where the value and percent labels are displayed in a chart. 3D charts and with-depth chart do not 
display labels.

• Above series and Below series are available for vertical series.
• Left of series and Right of series are available for horizontal series.



Series labels options
Series labels provide additional information about the values in a chart.

• Value labels. The numeric value of each series.
• Percent labels. The percentage each series represents of the whole.
• Slice labels. Available only for pie charts.



Chart: Mixed type
Combines different chart types into one chart. Mixed charts can include area, bar, or lines. To create a mixed chart, 
select "Mixed" on the Type panel of the InfoBox.



3D: Shadow
Controls the shadow below a 3D pie chart. 



Slice labels options
Pie labels include:

• Value labels. The value of each pie slice.
• Percent labels. The percentage each slice represents of the whole.
• Slice labels. Text associated with each slice.



Trend lines: Slope
A measure of the amount of slant in the trend line.



Pie charts: Sorting options
For multiple pies, you can specify how to sort the slices:

• Unsorted. Does not sort the slices. Slices are plotted in the order in which they appear in the data.
• Separately for each pie. Sorts the slices in each pie in ascending order in each pie.
• Based on first pie. Sorts the slices in each pie in the order they appear in the first pie.
• Based on last pie. Sorts the slices in each pie in the order they appear in the last pie.

Note Pies with independent data can use only Unsorted and "Separately for each pie."



Pie charts: Start angle
Controls the angle in a pie chart at which the first pie slice is displayed. By default, the first pie slice is displayed at 0 
degrees (12:00 on a 12-hour clock). Counterclockwise display begins at the 3:00 position. You can change where the 
first pie slice is displayed by entering a value under Start angle.



Types of trend lines
You can create the following types of trend lines:

• Linear: y = a + bx
• Exponential:    y = aebx
• Logarithmic:    y = a + b (ln x)
• Power:    y = axb, where a > 0

You can remove the trend line. Open the InfoBox and click the Series trend tab. Under Type, select None.



Chart tables: Grid lines
There are four types of grid lines in chart tables: 

• Horizontal grid lines that separate data cells (Horizontals).
• Vertical grid lines that separate data cells (Verticals).
• The vertical grid line that separates the data from the column headers (First vertical).
• The horizontal grid line that separates the data from the row headers (First horizontal).



Trend lines: Y-intercept
The location on the y-axis at which the trend line intersects the axis.



Designing three-dimensional charts
You can create dramatic three-dimensional (3D) and with-depth variations of line charts, bar charts, area charts, 
mixed charts, and pie charts. Using 3D effects suggests mass and volume in your data. In a true three-dimensional 
chart, you can rotate the chart. In a with-depth chart, the 3D effects are static.

• Use 3D effects when you want to emphasize trends, not individual values, as the data is harder to read in a three-
dimensional    or with-depth chart.

• Change the size and color of the 3D platform to make the chart stand out. See Changing the 3D platform.
• Change the platform or lighting to add depth to the chart. See Changing 3D for pie charts or Changing 3D for 

area, bar, line, and mixed charts.
• Rotate the chart or change the elevation to view the chart from a different perspective. See Changing 3D for pie 

charts or Changing 3D for area, bar, line, and mixed charts.
• Add space between the rows of series to make the chart easier to read. See Changing the spacing between 

series.



Designing effective charts
Charts help to make data more accessible and easier to recall. 

• Before you make a chart, determine your purpose, gather your data, and select a chart type that serves your 
purpose.

• Use emphatic headlines to clarify your message.
• Minimize extraneous words and chart parts. Use the chart to convey only the most important information.
• Choose a chart type that best illustrates the relationship between different data series.
• Add a note when more explanation is needed. See Adding a note to a chart.
• Show a general trend by omitting the grid lines. Use grid lines to stress exact values. 
• Change the axis scale to exaggerate differences between data series. See Changing the axis scale.
• Use labels for charts with a few series. Use a legend for charts with more than three series. 
• Legends are a good choice for charts with more than three series. Labels work well for charts with few series.

For more information about specific chart types, see:
• Designing pie charts .
• Designing area charts .
• Designing line charts .
• Designing radar charts .
• Designing horizontal bar charts .
• Designing stacked bar charts .
• Designing vertical bar charts .
• Designing scatter (XY) charts .
• Designing High-Low-Close-Open (HLCO) charts .



Designing area charts
Area charts emphasize trends and totals in data over time by highlighting the area under the line created by each 
data series.

• To compare values as percentages of the whole, change the y-axis scale to 100%. See Changing the axis scale.
• In a stacked area chart, the area at the bottom determines the look of the other areas; put the area you want to 

emphasize at the bottom, or put the smoothest area there.
• In a 3D area chart, increasing the gaps between the rows makes each series easier to distinguish. See Changing 

the spacing between series.



Using color and pattern in chart design
You can give a chart a distinctive appearance by using colors and patterns. 

• Instead of a blank chart background, choose a light fill color to highlight the chart on the page.
• Change the color for negative values. See Selecting one data point in a chart. 
• When using black and white, avoid clashing hatch patterns. Use gray-scale shading instead. See Changing colors

and patterns in charts.
• In Freelance Graphics, use SmartMaster colors for color compatibility between your chart and your presentation.



Designing horizontal bar charts
Horizontal bar charts are best for comparing values at a single point in time. For effective horizontal bar charts: 

• Emphasize a single bar by using a different fill pattern or color. See Changing colors and patterns in a chart .
• Show a clearer relationship between data series by changing the space between bars or clusters or bars. See 

Changing the spacing between series.
• Display data values beside the bars. See Displaying chart series labels.
• Substitute symbols or pictures for your bars to create a visual link between a bar chart and your topic. See 

Showing pictures instead of bars in a bar chart.
• Display values along the right edge of, or inside, bars to eliminate your viewer's visual trip to the scale. See 

Displaying data values with the series.



Designing High-Low-Close-Open (HLCO) charts
Use High-Low-Close-Open (HLCO) charts, or "stock market charts," to track data that fluctuates over time.

• Use HLCO charts whenever you need to show three or four values per point.
• Use candlestick markers in an HLCO chart to make it easier to read. See Changing markers in a chart . 
• Use a fifth data series to show a volume bar chart underneath the HLCO chart.



Designing line charts
Line charts trace the changes in sets of data over time. Line charts are the best choice when there are a lot of data 
points. For effective line charts: 

• Use three or fewer lines in a chart, especially if the lines cross. For more data sets, break the data into two charts 
on the same page.

• Make lines thicker than axes, and axes thicker than grid lines. See Changing line styles in a chart.
• Vary line styles and widths to differentiate lines, especially if you are using black-and-white, or want a single line 

to stand out.
• Use dashed or dotted lines to denote projected data or estimates.
• Use markers if you want to stress individual points, but be aware that markers can look cluttered.
• In a 3D line chart, increasing the gaps between the rows will make each series easier to distinguish. See 

Changing the spacing between series .



Designing mixed charts
Mixed charts combine parts from a line chart, a bar chart, or an area chart to show a comparison between two 
different types of data. For effective mixed charts: 

• Show the different series on different y-axes. See Plotting a series against a 2nd y-axis.
• Make the series with the largest values into an area, as that series will appear behind the other series.    See 

Changing the type of a series.
• When using areas and bars, make the bars narrow by increasing the gap between the bars, so that you can see 

the area displayed behind the bars. See Changing the space between bars.



Designing chart tables
A chart table contains the data values. To display a table of numeric data, use a number grid chart. To display a table 
of values below another chart, use a data table.

• Use a data table when you want to present the actual values for the chart. See Adding a table below a chart.
• Use a font size that is large enough to be legible. See Changing text fonts, sizes, and colors in a chart.
• Grid lines can add clarity to a chart containing many rows or columns of data. For charts with less dense data, 

consider omitting the grid lines. See Displaying grid lines in a chart table.
• Show the total values of each row or column when you want to summarize the data. See Calculating totals in a 

number grid.



Designing pie charts
Pie charts show the relationship of parts to the whole.

• Use 6 or fewer slices. Eliminate or combine remaining small slices. See Combining pie slices.
• Put the most important slice in the upper-right quadrant, or arrange slices in order from largest to smallest. See 

Sorting pie slices by size.
• Emphasize a slice by exploding it, or explode all the slices for a dramatic visual effect.    See Exploding pie slices.
• Display percent values next to slices when specific data is important. See Displaying pie slice labels.
• Change the color or pattern of a specific slice to call attention to it. See Changing colors and patterns.
• Show pie titles and totals to help explain the contents of your pie. See Showing pie titles and totals.

Multiple pie charts compare separate pie charts to each other. For multiple pie charts: 
• Scale the pie charts by height or area to emphasize pie charts representing larger amounts of data. See 

Changing the scaling of multiple pies.
• If you have more than two pie charts, arrange the charts so that they fall in different rows. See Changing the 

layout of multiple pies.
• If the slices in the different pies represent different types of data, use different slice labels for each pie. See Using 

different slice labels for multiple pies.



Designing radar charts
Radar charts compare data series consisting of several different variables.

• Use 3 or fewer lines per chart, especially if the lines cross. If you have more data sets, break your data into two 
charts on the same page.

• Make lines thicker than axes and axes thicker than grid lines. See Changing line styles.
• Vary line styles and widths to differentiate lines, especially if you are using black and white or want to emphasize 

a single line among several. See Changing line styles.
• Use dashed or dotted lines to denote projected data or estimates. See Changing line styles.
• Use markers if you want to stress individual points, but be aware that they add clutter. See Changing series 

markers.
• Change the axis scales to exaggerate differences between data series. See Scaling and arranging radar chart 

axes.
• Change the style of one or more series from line to area, to differentiate the series in your radar chart. See 

Changing the type of a series.



Designing stacked bar charts
Use a stacked bar chart when you want to compare totals as well as individual values for different time periods or 
categories of data.

• Make sure the segments of the bar add up to a meaningful total.
• Use five or fewer segments per bar (data sets).
• Use the darkest or densest fills for segments at the baseline or left. Use lighter fills as segments rise up or move 

right in the bar.
• To compare values as percentages of the whole, change the y-axis scale to 100%. See Changing the axis scale.
• If you want to draw attention to the changes in a specific data set, put that data set first so it appears on the 

bottom or left of the stacked bars.
• Substitute symbols or pictures for your bars to eliminate abstraction and create a strong visual message between 

your bar chart and your topic. See Using pictures instead of bars.
• Add connecting lines between bar segments to make it easier to compare values. See Connecting and 

disconnecting points and bars.
• Change the space between the bars to more effectively show the relationship between data series. See Changing

the space between areas, bars, and lines.



Designing vertical bar charts
Charts with vertical bars are good for comparing individual values over time. 

• You can display values along the tops of, or inside bars, to make the chart easier to read. See Displaying data 
values with the series.

• Use a different fill pattern or color to highlight a single bar to make a point. See Changing colors and patterns.
• Substitute symbols or pictures for your bars to eliminate abstraction and create a strong visual message between 

your bar chart and your topic. See Using pictures instead of bars.
• Change the space between the bars or clusters of bars to more effectively show the relationship between data 

series. See Changing the space between bars.



Designing scatter (XY) charts
Use scatter charts, also called XY charts, to look for correlation between large sets of data.

• Use scatter charts only if your audience has the statistical knowledge to interpret them.
• Add a trend line to show the general direction of the data points. See Adding trend lines.
• Use the line connecting the points to show the direction of the data. See Connecting and disconnecting points 

and bars.



Details: Adding axis titles and subtitles
Changing the text font, size, and style 
You can change the appearance of text by using the InfoBox. Select the text, then click the Text Format tab and 
choose a different font, size, and style.

Using range data for titles and subtitles
You can import data from a worksheet and use it as title text using the Import Data dialog box. See Linking chart text 
to a range.

{button ,AL(`H_LC_ADDING_AXIS_TITLE_STEPS',1)} Go to procedure



Adding axis titles and subtitles
Adding a title and subtitle  to an axis helps to explain the values on the axis. 
1. Choose Chart - Chart Properties.
2. Under Properties for, select the x-axis, y-axis, or z-axis.
3. Click the Titles tab.
4. Check Show title.
5. Enter a title.
6. Check Show subtitle.
7. Enter a title or check Based on scale.
8. Under Subtitle position, select where to display the subtitle.

{button ,AL(`H_LC_ADDING_AXIS_TITLE_DETAILS',1)} See details
{button ,AL(`H_LC_EDITING_TEXT_STEPS;H_LC_CHANGING_TEXT_COLORS_FONT_STEPS;H_LC_CHANGIN

G_AXIS_SCALE_STEPS;',0)} See related topics



Details: Adding grid lines and tick marks
Using the Grid tab options
The options on the Grid tab will vary depending on the chart type and axis you have selected.

• Bar, line, and area charts can have individual grid lines set for the y-axis. On the x-axis, you can only display the 
major interval grid lines.

• Scatter (X,Y) charts can have individual grid lines for both x-axis and y-axis.
• Pie charts do not have x-axis or y-axis options.

Making more changes to grid lines and tick marks
If you want to scale manually, click the Scale tab. This panel also controls the display of tick marks.
You can change the colors and line widths of grid lines. See Changing line styles in a chart.
You can hide grid lines, which can make some charts easier to interpret. See Hiding and showing parts of a chart.
You can modify the appearance of grid lines and tick marks to customize a chart. See Changing the look of grid lines 
and tick marks.

{button ,AL(`H_LC_ADDING_GRIDLINES_STEPS',1)} Go to procedure



Adding grid lines and tick marks
Grid lines and tick marks make it easier to read the values in a chart.

Setting grid lines
1. Choose Chart    - Axes & Grids, then choose either X-Axis & Grids, or Y-Axis & Grids.
2. Add grid lines and tick marks.

• To show grid lines, click the Grids tab. Under "Show grid lines at," check an interval. (To set individual grid 
lines, see below).

• To add tick marks, click the Ticks tab, then select the intervals and position.

Setting individual grid lines
1. On the Grids tab, check "Set individual grid lines."
2. Under "Number of grid lines," enter the number of individual grid lines you want to specify (up to 20).
3. Under "Line number," enter a number. 
4. Under "Line value," enter a number. This is the location of the first individual grid line.
5. To add more individual grid lines, enter a new line number and line value for each one.
Tip If you do not specify a line number or value, the major grid lines values are used.

{button ,AL(`H_LC_ADDING_GRIDLINES_DETAILS',1)} See details
{button ,AL(`H_LC_Changing_line_styles_STEPS;H_LC_ADDING_GRIDLINES_STEPS;',0)} See related topics



Overview: Axes and grid lines
Chart axes are lines against which the data is plotted.

The axes vary:
• Vertical bar charts, line, and area charts have a horizontal x-axis and vertical y-axis. You can optionally specify a 

2nd y-axis on the right.
• Horizontal bar charts have a vertical x-axis and horizontal y-axis and optional 2nd y-axis (top).
• 3D charts add a z-axis.
• Radar charts can have up to 40 axes.
• Pie charts have no axes.

Grid lines are the horizontal or vertical lines displayed through the plot of a chart. Grid lines are perpendicular to the 
axis to which they are associated.

Modifying the axes
To increase the effectiveness of a chart, you can:

• Add tick marks and grid lines to show exactly where each data point falls. See Adding grid lines and tick marks.
• Display titles to describe the axis. See Adding axis titles and subtitles.
• Change where the axes intersect, to prevent large gaps on a chart. See Changing the intersection of x- and y-

axes.
• Change the scale of the axis so it best displays the data. See Changing the axis scale and Scaling and arranging 

radar chart axes.
• Plot one or more series on a 2nd y-axis to show a different scale for that series. See Plotting a series against a 

2nd y-axis.



Details: Changing the intersection of x- and y-axes
To reset the intercept to the default, deselect the Intercept box.

Making other changes to the scale
You can select other options to change how the data is presented: 

• Click the Labels tab to change the intervals for the scale labels.
• Click the Grids tab to specify whether the grid lines should appear.
• Click the Scale tab to change the direction and position of the scale.

{button ,AL(`H_LC_CHANGING_AXES_INTERSECT_STEPS',1)} Go to procedure



Changing the intersection of x- and y-axes
Changing the intersection of the chart axes can make the chart easier to read.
1. Choose Chart - Chart Properties.
2. Under Properties for, select the axis.
3. Click the Scale tab.
4. Check the Intercept box.
5. Type a number for the intercept.

{button ,AL(`H_LC_CHANGING_AXES_INTERSECT_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_AXIS_SCALE_STEPS;',0)} See related topics



Details: Changing the axis scale
Options

• Scale manually: Instead of using the default values, you can create your own scale.
Maximum. Enter the highest value for the axis.
Minimum. Enter the lowest value for the axis.
Major ticks. Enter an interval value for the major tick marks. 
Minor ticks. Enter a value. If the minor or major tick marks do not appear, click the Ticks tab in the InfoBox, and 
check the "Show tick marks at" box for the tick marks.

• Intercept. Enter a value.
• Direction: Choose an ascending or descending scale.
• Position: For the x-axis, choose Top, Bottom, or Both. For the y-axis, choose Left, Right, or Both.
• Type: Choose Linear, Log, 100%.
• Units: Choose Auto, or other incremental values such as Thousands and Millions.

In most charts, you can manually scale only the y-axis and 2nd y-axis. In scatter (XY) charts, you can also change 
the x-axis scale.
The Maximum, Minimum, Major ticks, and Minor ticks settings are interrelated, so that changing one of these settings 
may affect the other settings. 

{button ,AL(`H_LC_CHANGING_AXIS_SCALE_STEPS',1)} Go to procedure



Changing the axis scale
To create a better fit for the data, you can change the scale of a numeric axis.
1. Choose Chart - Chart Properties.
2. Under Properties for, select an axis.
3. Click the Scale tab.
4. Under Scale manually, change the axis options. See details.

{button ,AL(`H_LC_CHANGING_AXIS_SCALE_DETAILS',1)} See details
{button ,AL(`H_LC_SCALING_RADAR_AXES_STEPS;H_LC_ADDING_GRIDLINES_STEPS;',0)} See related topics



Details: Changing the look of grid lines and tick marks
Selecting individual grid lines
To change an individual major grid line, hold the CTRL key and click the grid line. You can then change the line color, 
width, and style for the selected major grid line. The minor interval grid lines cannot be individually selected.

{button ,AL(`H_LC_CHANGING_GRIDLINES_STEPS',1)} Go to procedure



Changing the look of grid lines and tick marks
1. Choose Chart - Chart Properties.
2. Click a grid line on a chart.
3. Click the Lines & Color tab.

4. Under Grid lines and ticks, select Line Color, Line Width, and Line Style.
Tip Be sure to check the Show boxes on the Grids and Ticks panels to display the major and minor intervals of the 
grid lines and tick marks.

{button ,AL(`H_LC_CHANGING_GRIDLINES_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_GRIDLINES_STEPS;H_LC_CHANGING_LINE_STYLES_STEPS;',0)} See related 

topics



Details: Displaying axis labels
Options
Overlapping is optional for some axes. The Overlapping options include:

• Automatic. Uses the best arrangement for the labels.
• Stagger. Alternates the labels between two lines.
• Slant. Displays the labels at an angle.
• Vertical. Displays the labels vertically.
• Down. Displays the labels vertically.

Displaying long text labels
If you have labels with long names, you can make them fit better on the chart. You can:

• Change the text size. Open the InfoBox, then select the text in the chart. Click the Text Format tab, and select a 
smaller font size or different font.

• Use a different Overlapping option.
• Shorten the text. Under Character limit, enter a smaller number.
• Show fewer labels. Under Show labels every n ticks, enter a number other than 1.

{button ,AL(`H_LC_CHANGING_TICK_LABELS_STEPS',1)} Go to procedure



Displaying axis labels
You can specify how axis labels are displayed. The options vary depending on which axis is selected.
1. Choose Chart - Axes & Grids, then choose X-Axis & Grids or Y-Axis & Grids.
2. Click the Labels tab.
3. Check "Show labels every n ticks," and enter a number.
4. (Optional) Under Overlapping, select an option.
5. (Optional) Check "Character limit" and enter a number.

{button ,AL(`H_LC_CHANGING_TICK_LABELS_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_GRIDLINES_STEPS;H_LC_CHANGING_LINE_STYLES_STEPS;',0)} See related 

topics



Labeling radar chart axes
1. Select a radar chart.
2. Choose Chart - Edit Data.
3. Under Axis Titles, enter text.
4. Click OK.

{button ,AL(`H_LC_LABEL_RADAR_AXES_DETAILS',1)} See details
{button ,AL(`H_LC_SCALING_RADAR_AXES_STEPS;',0)} See related topics



Details: Scaling and arranging radar chart axes
Redisplaying grid lines
When you scale each axis independently, all the grid lines are turned off. To redisplay the grid lines, click the Scale 
tab and deselect Make axes independent. 

{button ,AL(`H_LC_SCALING_RADAR_AXES_STEPS',1)} Go to procedure



Scaling and arranging radar chart axes
1. Select a radar chart.
2. Choose Chart - Chart Properties. 
3. Under Properties for, select Axes.
4. Click the Scale tab.
5. (Optional) Under Scale manually, enter values.
6. (Optional) Check Make axes independent if you want each axis to use a different scale. 

{button ,AL(`H_LC_SCALING_RADAR_AXES_DETAILS',1)} See details
{button ,AL(`H_LC_LABEL_RADAR_AXES_STEPS;',0)} See related topics



Details: Adding data to a chart from a worksheet or file
Entering data in the file
For rowwise data, insert one or more rows. For columnwise data, insert one or more columns.

{button ,AL(`H_LC_ADDING_DATA_FILE_STEPS',1)} Go to procedure



Adding data to a chart from a worksheet or file
In Word Pro and Freelance Graphics, you can add a chart series using data stored in an external file.
1. Edit the data in the file using the application that you used to create the file.
2. Choose Chart - Edit Data.
3. Click Import Data.
4. Under File Name, enter the name of the file you want to use.
5. Click Open to open the file in the Edit Links dialog box.
6. Click the "Individual" button.
7. Select a series.
8. Select the data for the series from the worksheet.
9. Click Apply.
10. Click OK to close the Edit Links dialog box.

{button ,AL(`H_LC_ADDING_DATA_FILE_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_DATA_123_STEPS;H_LC_ADDING_DATA_TYPING_STEPS;',0)} See related topics



Details: Adding data to a chart by typing
Using the Edit Data dialog box
The worksheet in the Edit Data dialog box contains rows from 1 to 8192 and columns from A to AD. Use the scroll 
bars to move around the worksheet. 

Hiding the Preview window
If you want to see more of the worksheet, you can hide the Preview window. Click the Options button and deselect 
Show chart preview. Then click OK. 

Adding descriptive text
Annotations can help describe the chart data.

• Edit the legend, title, or label text. See Editing chart text.
• Hide or show text. See Hiding and showing parts of a chart

{button ,AL(`H_LC_ADDING_DATA_TYPING_STEPS',1)} Go to procedure



Adding data to a chart by typing
You can add values to an existing series by editing the data in the Edit Data window.
1. Select the chart.
2. Enter or edit the values.

• In the Label column, type the x-axis labels or pie titles.
• In the Legend row, type the legend text or pie slice labels.

3. Click OK. 
Tip Click the Edit Titles button to enter a chart title, note, and axis titles.

{button ,AL(`H_LC_ADDING_DATA_TYPING_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_DATA_123_STEPS;',0)} See related topics



Details: Adding a note to a chart
Changing text size, color, and style
You can change the size and appearance of the text using the InfoBox. Open the InfoBox. Under Properties for, 
select Note, then click the Text Format tab. Select the Font name, Size, Style, and Text color. You can change part of 
the text by selecting the text directly in the chart.

Deleting note text 
To delete a line of text, click the line of text in the chart, then press DELETE. You can edit or delete characters using 
the InfoBox or by editing directly in the chart.

Hiding the note
To hide the note, deselect "Show note" on the Options panel of the InfoBox.

{button ,AL(`H_LC_ADDING_NOTE_STEPS',1)} Go to procedure



Adding a note to a chart
1. Choose Chart - Note.
2. Click the Options tab.
3. Check the "Show note" box.
4. Under Line 1, enter the title text.
5. Under Line 2 and Line 3, enter the optional subtitle text.
Tip You can move the note anywhere on the chart. Click the note and drag it to another position. You can also use 
the Position buttons on the Options panel.

{button ,AL(`H_LC_ADDING_NOTE_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_TEXT_COLORS_FONT_STEPS;H_LC_EDITING_TEXT_STEPS;',0)} See related 

topics



Details: Adding titles to a chart
Other ways to add titles 
You can enter or edit chart titles using the Edit Data window. Choose Chart - Edit Data, then click the Edit title button. 
Enter one, two, or three lines of text.

Changing text size, color, and style
You can change the size and appearance of the text using the InfoBox. Choose Chart - Title, click the Text Format 
tab, then select the Font name, Size, Style, and Text color. To change individual lines, click the text in the chart to 
select it, then use the InfoBox to make the changes.

Deleting text 
To delete a line of text, double-click the line of text you want to delete and press DELETE. You can edit or delete 
characters using the InfoBox or by editing directly in the chart.

Hiding the title
To hide the title, deselect "Show title" on the Options panel of the InfoBox.

{button ,AL(`H_LC_ADDING_TITLE_STEPS',1)} Go to procedure



Adding titles to a chart
1. Choose Chart - Title.
2. Click the Options tab.
3. Check the "Show title" box.
4. Under Line 1, enter the title text.
5. Under Line 2 and Line 3, enter the optional subtitle text.
6. Under Position, click the button that corresponds to the position on the chart where the titles should appear.

{button ,AL(`H_LC_ADDING_TITLE_DETAILS',1)} See details
{button ,AL(`H_EDITING_TEXT_STEPS;H_LC_CHECKING_SPELLING_STEPS;H_LC_CHANGING_TEXT_COLOR

S_FONT_STEPS;',0)} See related topics



Details: Changing numeric formats in a chart
Options
You can choose how you want the selected numbers in a chart to be displayed.

• Format type. Choose from General, Currency, ISO Currency, Comma, Fixed, Scientific, Percent, Date, Time.
• Current format. If there are other options for the Format type you select, they appear here. The options vary 

depending on the Format type.
• Parentheses. Check this box if you want parentheses displayed around the numbers.
• Decimal places. Use the arrows to set the number of decimal places, or enter a number between 0 and 15.

{button ,AL(`H_LC_CHANGING_NUMERIC_FORMATS_STEPS',1)} Go to procedure



Changing numeric formats in a chart
You can change the format of labels on a numeric scaled axis or a pie chart. 
1. Choose Chart - Chart Properties.
2. Under Properties for, select the axis you want to format.
3. Click the Number Format tab.

4. Under Format type, select a format.
5. Under Current format, select from the list.
6. Under Decimal places, select a number.
7. Check the Parentheses box to add parentheses.

{button ,AL(`H_LC_CHANGING_NUMERIC_FORMATS_DETAILS',1)} See details
{button ,AL(`H_LC_TEXT_OVER;',0)} See related topics



Details: Changing text fonts, sizes, and colors in a chart
Changing fill colors
Title, legend, and note text appear in a box. You can change the fill pattern and colors of the box. From the InfoBox, 
click the Lines & Colors tab, and select the pattern and colors.

Hiding and showing text
You can control whether or not text appears by using the InfoBox. Open the InfoBox, then select a chart part, such as
Legend, Title or Series Labels from the "Properties for" list. Click the Options tab, and check the "Show" box if you 
want the selected chart part to appear on the chart.

Editing text
You can edit existing text directly on the chart. See Editing chart text.

{button ,AL(`H_LC_CHANGING_TEXT_COLORS_FONT_STEPS',1)} Go to procedure



Changing text fonts, sizes, and colors in a chart
1. Choose Chart - Chart Properties.
2. Under Properties for, select the part containing the text you want to change.
3. Click the Text Format tab.

4. Select the text you want to change.
• To apply changes to one line of text, click it.
• To apply changes to all text, click the frame around the text.

5. Under Font name, select a font.
6. Under Size, select a font size.
7. Under Style, select one of the emphasis options.
8. Under Text color, select a color.

{button ,AL(`H_LC_CHANGING_TEXT_COLORS_FONT_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_COLORS_STEPS;H_LC_CHANGING_LINE_STYLES_STEPS;',0)} See related 

topics



Checking the spelling in a chart
1. Select a chart.
2. Choose Edit - Check Spelling.
3. Under Check spelling of, select an option.
4. Under Include, check Data charts.
5. Click OK.

{button ,AL(`H_LC_EDITING_TEXT_STEPS;',0)} See related topics



Details: Editing chart text
Editing chart text using the InfoBox
The tabs in the InfoBox change depending the selection. To display the appropriate panel, select the name of the 
chart part under "Properties for," then click the tab to get to the panel you want:

• Chart title. Select Title, then click the Options tab.
• Legend text. Select Series, then click the Options tab.
• Axis titles. Select the X-axis, Y-axis, or Z-axis, then click the "Titles" tab.
• Note. Select Note, then click the Options tab.

Editing chart text using the Edit Data dialog box
Choose Chart - Edit Data to display the Edit Data dialog box. You can add or edit chart text such as legends and 
labels. Click the Edit Titles button to display the Edit Titles dialog box. You can add or edit chart titles, a note, or axis 
titles.

Editing linked text
When text in a chart is linked to a data source, you cannot edit the text itself unless you break the link. To break the 
link, double-click the linked text and use the dialog box to break the link. 
When you double-click linked text, a dialog box appears asking if you want to break the link.
You can also create a link to a range and use that text in a chart. See Linking chart text to a range.

{button ,AL(`H_LC_EDITING_TEXT_STEPS',1)} Go to procedure



Editing chart text
Editing in place on the chart
1. Double-click the chart text you want to edit.
2. Do one of the following:

• To replace all the selected text, start typing. The selected text disappears and the new text replaces it.
• To edit part of the text, move the cursor to the point where you want to edit and click, then edit the text.

Editing using the InfoBox
1. Choose Chart - Chart Properties.
2. Under Properties for, select a chart part (Title, X-axis, Y-axis, Series, Note).
3. Click the Options or Titles tab to edit the text. See details.
Tip To cancel your edits, press ESC or choose Edit - Undo.

{button ,AL(`H_LC_EDITING_TEXT_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_NOTE_STEPS;H_LC_CHECKING_SEPLLING_STEPS;H_LC_CHANGING_TEXT_CO

LORS_FONT_STEPS;',0)} See related topics



Details: Linking chart text to a range
Breaking links
In a linked chart, editing the text breaks the link. To break a link, double-click the text directly in the chart and type a 
new value. You can then choose whether you want to abandon changes, delete only the affected links, or delete all 
links.

{button ,AL(`H_LC_LINKING_TEXT_STEPS',1)} Go to procedure



Linking chart text to a range
You can link chart text to a range in a worksheet or file.
1. Choose Chart - Import Data.
2. Click "Individual" to display the Edit Individual Links dialog box.
3. Select the chart part you want to link.
4. Select the range in the worksheet.
5. Click Apply.
6. Click OK to return to the Edit Data dialog box.
7. Click OK.
Tip Check "Keep file links" if you want to create a link.

{button ,AL(`H_LC_LINKING_TEXT_DETAILS',1)} See details
{button ,AL(`H_LC_EDITING_TEXT_STEPS;H_LC_CHANGING_TEXT_COLORS_FONT_STEPS;',0)} See related 

topics



Overview: A note in a chart
When you want to provide extra information in a chart, add a note. The note appears in a separate, moveable box 
within the chart. 

A note can be useful to explain unusual data results or to provide more information about how data was collected.
To use a note in a chart:

• Create a note. There is a limit of one note in a chart. The note can contain up to three lines of text. See Adding a 
note to a chart .

• Edit the text. See Editing chart text.
• Change the appearance of the text. See Changing text font, sizes, and colors.
• Hide the note. This allows you to provide a comment about the chart, but not display it. See Hiding and showing 

parts of a chart.



Overview: Chart text and numbers
Adding text to a chart, such as titles and axis labels, can help clarify the meaning of the data. Including numbers on a 
chart adds precision.
On a chart, you can:

• Add, delete, or modify text. See Editing chart text.
• Change the appearance of text by changing its attributes, such as font, size, and color. See Changing text fonts, 

sizes, and colors in a chart.
• Enter the text manually. See Creating a chart from worksheet data.
• Read in the values through a link to worksheet data. See Linking chart text to a range.
• Check your spelling. See Checking the spelling in a chart. 
• Modify the format of numbers in your chart. See Changing numeric formats in a chart.



Overview: Titles in charts
The chart title provides important documentation about your chart. It annotates the chart, labels its contents, and 
distinguishes one chart from another.

When working with a chart title, you can: 
• Edit the text by adding or deleting characters. See Editing chart text.
• Create a title or subtitle. See Adding titles to a chart.
• Add or hide a border around the title. See Changing the look of a chart border.
• Move the title to another location around the plot. See Moving a chart part.
• Resize the title box. See Resizing a chart or chart part.
• Change the appearance of the title text. See Changing text fonts, sizes, and colors .
• Hide the title or show a previously hidden chart title. See Hiding and showing parts of a chart.
• Create a title. See Adding titles to a chart.

Charts can also have axis titles, which are labels for an axis. See Adding axis titles and subtitles .

 



Details: Showing pictures instead of bars in a bar chart
Options
Under Picture size, you can specify how the picture is represented in the bar:

• Stretch to fill bar. Places one image in each bar, stretching the image as necessary so that it fills the bar.
• Preserve aspect ratio. Enlarges or shrinks the picture so that its width fits the bar. As many images as can fit are 

stacked in the bar. The last picture can be fractional.
• One picture equals nn <units>. Makes each picture equivalent to the specified number of y-axis units.

File types supported
You can use the following file type:

• .bmp

{button ,AL(`H_LC_ADDING_PICTOGRAMS_STEPS',1)} Go to procedure



Showing pictures instead of bars in a bar chart
You can put a picture inside a bar, stacked bar, or 100% stacked bar.
1. Create or find the picture you want to use, and copy it to the Clipboard.
2. Choose Chart - Series.
3. Click the Pictures tab.
4. Select a series.
5. Under Picture size, select an option. See details.
6. Click "Paste Picture."

{button ,AL(`H_LC_ADDING_PICTOGRAMS_DETAILS',1)} See details
{button ,AL(`H_LC_TYPES_CHANGING_STEPS;H_LC_CHANGING_COLORS_STEPS;H_LC_CHANGING_LINE_S

TYLES_STEPS;',0)} See related topics



Changing the spacing between series
You can change the spacing between series for bar charts.
1. Choose Chart - Chart Properties.
2. Under Properties for, select Plot.
3. Click the Layout tab.
4. Under Gap%, type a number between 0 (no space) and 100 (the width of the bars in each group).
Tip If you want to overlap the bars in each cluster, enter a number for Overlap %.

{button ,AL(`H_LC_STACKING_SERIES_STEPS;',0)} See related topics



Details: Changing markers in a chart
The marker outline is the same color and width as the line itself. The markers cannot be resized separately.

Troubleshooting
If the Marker information does not appear in the Lines & Colors panel, be sure you have a series selected. You can 
select a series by clicking it, or by selecting it from the "Properties for" list at the top of the InfoBox.

{button ,AL(`H_LC_CHANGING_MARKERS_STEPS',1)} Go to procedure



Changing markers in a chart
Markers can be used in line, mixed, scatter (XY), and radar charts.
1. Choose Chart - Series.
2. Click the Options tab and select a series.
3. Click the Lines & Colors tab.

4. Check Show marker.
5. Select a Marker Symbol and Marker Color.

{button ,AL(`H_LC_CHANGING_MARKERS_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_LINE_STYLES_STEPS;',0)} See related topics



Details: Changing to a mixed chart type
Here are some guidelines to help you create an effective mixed chart.

• Lines and bars are an effective combination. For example, the line could track the sales of shoes over several 
years, while the bars could show the percentage share of the market. Lines are good for emphasizing continuity 
of data over time while bar charts emphasize values for individual time periods.

• Areas and lines are also useful. Use "area" for one of the series when you want to present a general trend rather 
than the individual bars.

{button ,AL(`H_LC_CHANGING_SERIES_TYPE_STEPS',1)} Go to procedure



Changing to a mixed chart type
A mixed chart can combine bar, area, and line series into one chart.
1. Choose Chart - Series.
2. Click the Options tab.
3. Select a series from the series list
4. Under Mixed type, select Area, Bar, or Line for the selected series.
5. Repeat for each series you want to change.
Tip On the Type panel, the chart type will now be "Mixed."

{button ,AL(`H_LC_CHANGING_SERIES_TYPE_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_COLORS_STEPS;H_LC_CHANGING_LINE_STYLES_STEPS;',0)} See related 

topics



Connecting points in charts
Connecting points in a scatter chart
1. Choose Chart - Series.
2. Click the Options tab, and select a series.
3. Click the Lines & Colors tab.
4. Check "Connect points."

{button ,AL(`H_LC_CHANGING_MARKERS_STEPS;',0)} See related topics



Details: Displaying chart series labels
Label placement
You can control where the labels in each series appear.

• Vertical bar chart series labels appear above or below the bars.
• Horizontal bar chart series labels appear to the right of, or just inside the bar. 
• Stacked bar chart series labels display only below the bars.
• Charts with-depth and 3D charts do not display series labels.

Changing the appearance of label text
You can select the label text,    then change its font, size, style and color. See Changing text fonts, sizes, and colors in
a chart.

{button ,AL(`H_LC_DISPLAYING_VALUES_STEPS',1)} Go to procedure



Displaying chart series labels
You can display the value or percent labels for any series you select.
1. Choose Chart - Chart Properties.
2. Under Properties for, select Series labels.
3. Click the Options tab.
4. Select a series from the list.
5. Do one or more of the following:

• Check "Show value labels."
• Check "Show percent labels."
• Under Position, select a location.
• Under Orientation, select a rotation.

Tip A pie chart can also display slice labels. See Displaying pie slice labels .

{button ,AL(`H_LC_DISPLAYING_VALUES_DETAILS',1)} See details
{button ,AL(`H_LC_ROTATING_VALUES_STEPS;',0)} See related topics



Details: Plotting a series against a 2nd y-axis
Plotting the series against the first y-axis
You can change which axis the series is plotted against. Choose Chart - Series, and click the Options tab. Select the 
series from the pull down list, and uncheck "Plot against 2nd Y-axis." If this is the only series plotted on that axis, 
deselecting "Plot against 2nd Y-axis" removes the 2nd y-axis from the chart.

Using a 2nd y-axis with an HLCO chart
You cannot add a 2nd y-axis to a high-low-close-open chart because the 2nd y-axis is reserved for the fifth data 
values (the volume data).

{button ,AL(`H_LC_PLOTTING_SERIES_ON_2Y_STEPS',1)} Go to procedure



Plotting a series against a 2nd y-axis
A 2nd y-axis uses a separate scale to plot the selected series.
1. Choose Chart - Chart Properties.
2. Under Properties for, select Series.
3. Click the Options tab.
4. Select a series. This series will be plotted against the 2nd y-axis.
5. Check "Plot against 2nd Y-axis."
Tip To change the scaling on the 2nd y-axis, click the axis to select it, then click the Scale tab in the InfoBox. Under 
Scale manually, enter new scaling values. 

{button ,AL(`H_LC_PLOTTING_SERIES_ON_2Y_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_AXIS_SCALE_STEPS;',0)} See related topics



Rotating chart series labels
Rotating series labels make labels more legible when the labels contain a lot of text or are close together.
1. Choose Chart - Chart Properties.
2. Under Properties for, select Series labels.
3. Click the Options tab.
4. Select a series from the list.
5. Check the "Show" box for the labels you want to display.
6. Under Orientation, select a rotation.

{button ,AL(`H_LC_CHANGING_PIE_LABELS_STEPS;H_LC_CHANGING_ORIENTATION_STEPS;H_LC_EDITING
_TEXT_STEPS;',0)} See related topics



Overview: Chart series
A series is a set of values plotted on a chart. In this example, the New York values are a series, and the Paris values 
are a series.

If you assign series by column, each column of data represents a series. If you assign series by rows, each row of 
data represents a series.
In pie charts, each pie represents a single series, with each slice in the pie showing a data value for that series.
A series can be modified. You can:

• Delete data series from a chart. See Deleting chart data.
• Hide a series. See Hiding and showing parts of a chart.
• Stack the series. See Changing to a different chart type.
• Change the spacing between series by overlapping or increasing the space. See Changing the spacing between 

series.
• Show the numeric value for the series. See Displaying chart series labels.
• Connect bars and markers. See Connecting points and bars in charts.
• Choose a different marker used for a series. See Changing markers in a chart.
• Use different colors in a series. See Changing colors and patterns in a chart.
• Add pictures to bars in a chart. See Using pictures instead of bars in a bar chart.
• Plot a series on a second y-axis. See Plotting a series against a 2nd y-axis.
• Change a series from one type to another, such as bars to areas. See Changing to a different chart type.



Details: Stacking and overlapping chart series
Using stacking options
You can stack, overlap, and cluster the series in a chart to make the chart easier to read or the data easier to 
compare.

• Stacking the series emphasizes the total volume of the series. Positive numbers are stacked above the axis line 
and negative numbers are stacked below the line.

• Clustering the bars into a group compares related sets of items over time. Clustering emphasizes the value of 
each item in the set, rather than the sum of the items. See Changing the spacing between series.

{button ,AL(`H_LC_STACKING_SERIES_STEPS',1)} Go to procedure



Stacking and overlapping chart series
To stack bars or areas
1. Choose Chart - Chart Type.
2. Click the Type tab.
3. Under Chart type, select "Stacked Bar," "100% Stacked Bar," or "Area."

To overlap bars or areas
1. Choose Chart - Chart Properties.
2. Under Properties for, select Plot.
3. Click the Layout tab.
4. Do one of the following:

• For an area chart, under "Areas," select "Overlapped."
• For a bar chart, enter a value for "Overlap %."

Tip Overlap % is not available for 3D bar charts.

To stack lines
1. Choose Chart - Chart Properties.
2. Under Properties for, select Plot.
3. Click the Layout tab.
Tip Under Lines, select "Stacked."

{button ,AL(`H_LC_STACKING_SERIES_DETAILS',1)} See details
{button ,AL(`H_LC_TYPES_CHANGING_STEPS;',0)} See related topics



Details: Adding a trend line to a chart
When you select the trend type, the values for the R-square, slope, and y-intercept for the trend line appear.    These 
are the values that display in the note if you select "Show regression information in note." These values overwrite any
existing chart notes.
If you select "Show regression information in note," the trend information appears on the Series trend panel of the 
InfoBox, even if you do not show the note in the chart.

{button ,AL(`H_LC_ADDING_REGRESSION_STEPS',1)} Go to procedure



Adding a trend line to a chart
You can add a trend line to a series in a scatter (XY) chart to show the correlation between the values.
1. Choose Chart - Series.
2. Click the Series trend tab.
3. Select the series from the list. The trend line will be added to the selected series.

The series must have at least three data points.
4. Select the trend type.
Tip To display information about the trend line in the chart note, select "Show regression information in note."

{button ,AL(`H_LC_ADDING_REGRESSION_DETAILS',1)} See details
{button ,AL(`H_LC_SPECIFYING_MIN_MAX_REGRESSION_STEPS;',0)} See related topics



Overview: Series trend lines
A trend line, also called a regression line, is a line associated with a data series that shows the general trend of the 
series.

In a chart, you can:
• Add a trend line to any series in a scatter (XY) chart that contain markers. See Adding a trend line to a chart.
• Control which values will be included in the trend line, thereby excluding outlying data from the analysis. See 

Specifying the values to calculate in a trend line.
• Specify where you want to display the line. See Specifying where to display a trend line.
• Optionally display information about the analysis, such as y-intercept, slope, and R-square in the chart note. See 

Adding a note to a chart.
Once the line is part of the chart, you can modify it by changing its color or line style. The line and series color are 
always the same. See Changing line styles in a chart.



Details: Specifying where to display a trend line
The minimum and maximum y-axis values do not exclude data points from the trend calculation. The actual values 
used in the trend analysis are controlled by the start and end points.

{button ,AL(`H_LC_SPECIFYING_MIN_MAX_REGRESSION_STEPS',1)} Go to procedure



Specifying where to display a trend line
You can specify the minimum and maximum x-values for the trend line. If you do not specify these values, the trend 
line is drawn across the entire width of the x-axis.
1. Choose Chart - Series.
2. Click the Series Trend tab.
3. Select a series.
4. Enter the minimum and maximum x-axis values.

{button ,AL(`H_LC_SPECIFYING_MIN_MAX_REGRESSION_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_REGRESSION_STEPS;',0)} See related topics



Specifying the values to calculate in a trend line
You can control the first and last points for which the trend line is calculated. Enter these values when your data fits 
the trend line well except for the points at the beginning and end of the series.
1. Choose Chart - Series.
2. Click the Series trend tab.
3. Select the series.
4. Enter values for "Start at point" and "End at point."

If you do not specify a start point or end point, all of the values in the series are used in the calculation.
The start and end points do not specify the values where the trend line displays. To specify where to display the trend
line, use the Minimum and Maximum attributes.

{button ,AL(`H_LC_SPECIFYING_MIN_MAX_REGRESSION_STEPS;',0)} See related topics



Details: Adding a series to a chart
Editing a series
You can also edit or delete series values using the Edit Data dialog box (Chart - Edit Data).

Working with imported series
Use the Edit Individual Links dialog box to make changes to a series that is linked to outside data sources. See 
Linking chart data to a range. 

{button ,AL(`H_LC_ADDING_SERIES_STEPS',1)} Go to procedure



Adding a series to a chart
1. Select the chart to which you want to add a series.
2. Choose Chart - Edit Data.
3. Enter the values for the new series.
4. Click OK.

{button ,AL(`H_LC_ADDING_SERIES_DETAILS',1)} See details



Details: Adding a table below a chart
Changing line colors in a table
You can change the line colors in a table. With the table selected, open the InfoBox and click the Lines & Colors tab. 
Under Line, click the icon that represents the lines you want to modify. Then select a color, width, and style for the 
selected line.

Troubleshooting
You cannot add a table under a number grid.

{button ,AL(`H_LC_ADDING_TABLE_UNDER_STEPS',1)} Go to procedure



Adding a table below a chart
You can place a table containing the chart data directly below a chart.
1. Choose Chart - Table.
2. Click the Options tab.
3. Check Show data table.
Tip From the Options tab, you can control the display of the row and column headers, and specify whether the 
selected series appears in the table or chart.

{button ,AL(`H_LC_ADDING_TABLE_UNDER_DETAILS',1)} See details
{button ,AL(`H_LC_DISPLAYING_VALUES_STEPS;',0)} See related topics



Details: Calculating totals in a number grid
Hiding totals in a number grid
You can temporarily hide selected totals in a number grid. On the Options panel, select a series from the list at the 
bottom of the panel. Uncheck "Show series in table." To redisplay the series, check the box.

Creating a number grid chart
A number grid chart contains only numbers. To create a number grid chart, choose Chart - Chart Type. In the InfoBox,
click the Type tab. Under Chart Type, select Number Grid from the list. 
You can also add a table below an existing bar, line, or area chart. A table displays the values used in the chart. 
Choose Chart - Table, then click the Options tab, and check Show data table.

{button ,AL(`H_LC_CALCULATING_TOTALS_STEPS',1)} Go to procedure



Calculating totals in a number grid
You can create an extra column or row in a number grid chart for calculating numeric value totals.
1. Select a number grid chart.
2. Choose Chart - Table.
3. Click the Options tab.
4. Check "Show row totals" or "Show column totals."
5. (Optional) Enter text for "Row totals label" or "Column totals label."

{button ,AL(`H_LC_CALCULATING_TOTALS_DETAILS',1)} See details
{button ,AL(`H_LC_ADDING_TABLE_UNDER_STEPS;',0)} See related topics



Changing text in a table or number grid
You can modify the appearance of text in a chart table or number grid.
1. Choose Chart - Table.
2. Click the Text Format tab.
3. Select the series text you want to change.
4. Under Font name, select a font.
5. Under Size, select the font size.
6. Under Style, select a style for emphasis.
7. Under Text color, select a text color.
Note Selecting one item in a series selects the entire series.

{button ,AL(`H_LC_ADDING_TABLE_UNDER_STEPS;H_LC_DISPLAYING_SEPARATORS_STEPS;',0)} See related
topics



Displaying row and column headers in a table or number grid
1. Choose Chart - Table.
2. Click the Options tab.
3. Check "Show row headers" or "Show column headers."
Tip You can hide a row or column header and its data. Select the series name from the list at the bottom of the 
Options panel, then deselect "Show series in table."

{button ,AL(`H_LC_DISPLAYING_ROW_COL_HEADERS_DETAILS',1)} See details
{button ,AL(`H_LC_DISPLAYING_SEPARATORS_STEPS;',0)} See related topics



Details: Displaying grid lines in a table or number grid
Options 

• Show line in header. Displays lines in the header.
• Show line in data. Displays grid lines in the data portion of the table or number grid.

Changing the color and line style of grid lines
When you click a line icon, the selection in the table or number grid changes to show you what is selected. You can 
then select a line color, line width, and line style. If the lines do not appear, be sure that the "Show line in header" or 
"Show line in data" box is checked. 

{button ,AL(`H_LC_DISPLAYING_SEPARATORS_STEPS',1)} Go to procedure



Displaying grid lines in a table or number grid
1. Choose Chart - Table.
2. Click the Lines & Colors tab.

3. Under Line, click the icon that represents the lines you want to change.
4. Select a Color, Width, and Style for the selected lines.
5. (Optional) Check "Show line in header" and "Show line in data."
Tip If you want to display row and column headers, click the Options tab, then check the appropriate box.

{button ,AL(`H_LC_DISPLAYING_SEPARATORS_DETAILS',1)} See details
{button ,AL(`H_LC_DISPLAYING_TABLE_FRAME_STEPS;H_LC_DISPLAY_ROW_COLUMN_STEPS;',0)} See 

related topics



Changing the look of a table or number grid
1. Choose Chart - Table.
2. Click the Lines & Colors tab.

3. Under Interior, select Pattern, Pattern color, and Background.
Tip You can also change the grid line color using the Lines & Colors panel. See Displaying grid lines in a table or 
number grid .

{button ,AL(`H_LC_DISPLAYING_SEPARATORS_STEPS;',0)} See related topics



Overview: Chart tables
A chart table can be either a number grid or a data table.

• Number grids are charts themselves. A number grid shows the actual numeric and text values. There is no 
graphical representation.

• Data tables appear under charts. A data table displays the data values that correspond to the chart.

For number grids and data tables, you can:
• Show grid lines between the rows and columns. See Displaying grid lines in a chart table.
• Change lines and colors. See Changing the look of a table or number grid.
• Display row and column headers. See Displaying row and column headers in a chart.
• Choose different colors and line styles used in a row or column. See Changing the look of rows and columns.
• Calculate row or column totals. See Calculating row and column totals in chart tables.



Details: Assigning series in a scatter chart
By default, all y-series in scatter charts use the same x-values.    The x-values are read from the first column in the 
data (for data assigned by column), or from the row (for data assigned by row).    For example: 

X Y1 Y2 Y3
42 53 55 54
44 57 56 61
49 56 52 59

This data would create a chart with three series, with the points of each series lined up along the x-values.    For 
example, the first point in all three series would fall at 42 on the x-axis, the second point would fall at 44, and so on.
When you select separate x-values, the columns or rows are paired in the data so that each column of y-values has a
corresponding column of x-values. For example:

X1 Y1 X2 Y2
42 53 55 54
44 57 56 61
49 56 52 59

This data would now create a chart with two series, the first with points at (42, 53) (44, 57), and (49, 56), and the 
second with points at (55, 54), (56, 61), and (52, 59).
When using separate x-values, if you have an odd number of series, the last series is ignored. 

{button ,AL(`H_LC_ASSIGNING_SERIES_STEPS',1)} Go to procedure



Assigning series in a scatter chart
In a scatter chart, you can use a separate x-series for each y-series.
1. Choose Chart - Plot.
2. Click the Layout tab.
3. Check "Separate X values." 

{button ,AL(`H_LC_ASSIGNING_SERIES_DETAILS',1)} See details



Details: Changing how chart data is assigned
The way series are plotted will vary depending on the chart type:

• Bar, area, and line charts can display up to 30 series.
• A single pie chart plots only the first series. Each intersection of row and column represents the value for each 

slice.
• Multiple pie charts plot each series in a separate pie chart.

{button ,AL(`H_LC_CHANGING_DATA_ASSIGNED_STEPS',1)} Go to procedure



Changing how chart data is assigned
You can control whether data is plotted by columns or by rows.
1. Select a chart. 
2. Choose Chart - Edit Data.
3. Click Series in columns or Series in rows.
Tip This option is also available when you are importing data using the Edit Links or Edit Individual Links dialog box.

{button ,AL(`H_LC_CHANGING_DATA_ASSIGNED_DETAILS',1)} See details
{button ,AL(`H_LC_LINKING_DATA_STEPS;H_LC_MODIFYING_CHART_DATA_STEPS;',0)} See related topics



Overview: Chart data
You can gather data for a chart by using any of the following methods:

• Manual data entry. See Adding data to a chart by typing.
• Worksheet. Worksheet data can be linked to the chart. Changes to the source data will automatically update in 

the chart. If the link is broken, changes to the source data will not affect the chart data. See Linking chart data to a
range.

Using a number grid or table
If you want to show the actual data values instead of a graphical representation, you can create a number grid. 
If you want to show the data values and graphic representation together, you can create a table that appears with the 
chart. See Adding a table below a chart.

How charts are generated from data
You can specify how you want rows and columns of data to appear in the chart. 

• Bar, line, and area chart. The values in the first column are used for the x-axis. Each of the following columns is a 
series.

• Pie chart. A single pie chart uses one column of data. The labels for the slices are the values in the first column. 
Extra data is ignored.

• Multiple pie charts. A separate pie chart is created from each column, where each value is a slice. As with a single
pie chart, the labels for the slices are the values in the first column. You can also use independent data for each 
of the pies.

• Scatter chart. The first column contains x-axis values. The remaining columns contain y-axis values.
• High-Low-Close-Open (HLCO) chart. Creates a different marker for each column. Column 1 contains the high 

values, column 2 contains the low values, column 3 contains the close values, column 4 contains the open 
values. If you have a fifth column, a volume bar chart appears at the bottom of the HLCO chart. Columns 
numbered 6 and higher are line series.

• Radar charts. Each row represents a different axis in the chart. Each series appears as lines connecting the 
points on the axes. 

• 3D and with-depth charts. These chart types use the same data organization as 2D charts. While the display 
properties of a chart change when you add depth or 3D, the data remains two-dimensional.



Details: Cutting and pasting data into a chart
Accepted file formats
You can paste data from the following types of files:

• 1-2-3: WK3, WK4, WK5
• Symphony: WR1
• Excel: XLS
• dBASE: DBF
• ASCII numbers: PRN
• ASCII text: PRN

{button ,AL(`H_LC_CREATING_FROM_CLIPBOARD_STEPS',1)} Go to procedure



Cutting and pasting data into a chart
You can copy data from a worksheet to a chart using the Edit Data window.
1. Select the data in the worksheet and copy it to the Clipboard.
2. Choose Chart - Edit Data.
3. Place the insertion point where you want to paste the data.
4. Press CTRL + V.
5. Click OK.

{button ,AL(`H_LC_CREATING_FROM_CLIPBOARD_DETAILS',1)} See details
{button ,AL(`H_LC_CREATING_BY_TYPING_STEPS;',0)} See related topics



Details: Linking chart data to a range
Linking chart parts
You can link the following chart parts to a range in a worksheet:

• Chart title
• Axis titles and subtitles
• Series labels
• Pie slice labels
• Legend
• Pie title

Turning off links
To turn off the link, deselect the Link box for the chart part. The data is then copied to the InfoBox. You can view and 
modify the data using the InfoBox or in the chart. You cannot type a value for a chart part when the Link box is 
selected for that part.

{button ,AL(`H_LC_LINKING_DATA_STEPS',1)} Go to procedure



Linking chart data to a range
You can link parts of a chart to data in an external file. When the file changes, the linked part updates automatically.
1. Choose Chart - Import Data.
2. In the Open dialog box, enter the name of the file containing the data, then click Open.
3. Do one of the following:

• To assign ranges for a group, use the Edit Links dialog box. 
• To assign ranges for chart parts or individual series, click the Individual button (at the bottom) to display the 

Edit Individual Links dialog box.
4. Select the worksheet cells.
5. Click the appropriate box.
6. (Optional) Check the Keep file links box.
7. Click OK. 

{button ,AL(`H_LC_LINKING_DATA_DETAILS',1)} See details
{button ,AL(`H_LC_LINKING_TEXT_STEPS;',0)} See related topics



Details: Modifying typed or copied chart data
Using the Edit Data window
You can use the Edit Data window (Chart - Edit Data) to modify the data, the legend, and the axis labels.

Editing titles
There are two ways of entering and editing text for the chart title, axis titles, and chart note.

• InfoBox. Choose Chart - Chart Properties to open the InfoBox. Under "Properties for," select the part you want to 
edit. Click the Options tab. Enter the text in the Options panel.

• Edit Data dialog box. Choose Chart - Edit Data, then click the Edit Titles button. Enter the chart title, note, or axis 
title.

The title and note can each contain up to three lines of text. Axis titles are one line. Enter a title for the 2nd y-axis if 
you expect to plot one or more series on that axis. See Plotting a series against a 2nd y-axis .    

{button ,AL(`H_LC_MODIFYING_CHART_DATA_STEPS',1)} Go to procedure



Modifying typed or copied chart data
You can change manually-entered data using the Edit Data window.
1. Choose Chart - Edit Data.
2. Edit the values in the Edit Data window.
3. (Optional) Click Edit Titles, and change the titles.
4. Click OK.
Tip If you imported the data for your chart, you can modify the ranges used to create the chart.
 

{button ,AL(`H_LC_MODIFYING_CHART_DATA_DETAILS',1)} See details
{button ,AL(`H_LC_EDITING_TEXT_STEPS;',0)} See related topics



Overview: Parts of a chart
A chart illustrates numeric data. A chart contains one or more series, a plot, and axes (except pie charts). Some of 
these parts appear automatically with the chart style you choose. You can add or change parts of a chart using the 
InfoBox (Chart - Chart Properties).

For a description of each chart part, click the green, underlined text below.
• Title. See Adding titles to a chart. .
• Legend. See Overview: Chart legend.
• Axis titles    and axis subtitles. See Adding axis titles and subtitles.
• Grid lines.
• Tick mark labels.
• Chart note.
• Pie slice labels.
• Series labels.
• 2nd y-axis. See Plotting a series against a 2nd y-axis.
• Chart tables.
• Stack totals.
• Pie titles.
• Pie totals.



Overview: Creating and using charts
Charts are a great way to communicate numeric data graphically. A chart makes it easy to see trends and to make 
comparisons. Both a graphical chart and a table of numeric data can appear in a single document.
A chart can be simple, based on defaults, or customized, such as adding a corporate logo or standardizing on a text 
font for consistency in a presentation.

Choose a chart type and style
You can choose a chart type (such as bar, pie, or area chart), and chart style. The chart style provides standard, 
compatible colors and text for the series, line styles, text, and other display characteristics. You can choose a different
chart type or style as you work with a chart. See Changing to a different chart type.
For detailed information about creating a chart in a Lotus application, see the Help for that application.

Use data
Data for a chart can come from: 

• Manual data entry. See Adding data to a chart by typing.
• A worksheet, such as 1-2-3. See Adding data to a chart from a worksheet or file.
• A database, such as Approach.
• Linking data from a worksheet to a chart. See Linking chart data to a range.

Customize a chart
The InfoBox makes it easy to add custom details to a chart. You can:

• Modify the text font, size, and style. See Changing text fonts, size, and colors in a chart.
• Change the colors of chart parts. See Changing colors and patterns in a chart.
• Include a table of data below the chart. See Adding a table below a chart.

Save, print, or share your chart
Once you have a chart you can: 

• save the chart as part of the document.
• save the current chart as the default chart.
• print the chart.
• copy the chart to another document.



Creating a chart by typing data
1. Choose Create - Chart.
2. Select a chart type and chart style.
3. Click OK to display the Edit Data window.
4. Enter the data.
5. (Optional) Enter label and legend text.
6. Click OK.
Tip If you want to enter a chart title, chart note, and axis titles, click the Edit Titles button.

{button ,AL(`H_LC_ADDING_DATA_TYPING_STEPS>STEPS',0)} See related topics



Creating a chart from worksheet data
You can import data from a worksheet to create a chart in Freelance Graphics and Word Pro.
1. Choose Create - Chart.
2. Select a chart type and chart style.
3. Click OK to display the Edit Data window.
4. Click Import Data.
5. Type the name of the file containing the data you want to import.
6. In the Edit Links dialog box, follow the steps to select worksheet data and assign it to parts of a chart.
7. (Optional) Check Keep file links if you want to maintain a link between the worksheet data and the chart.



Overview: Chart legend
The legend identifies each series.

You can:
• Hide or display the legend. See Hiding and showing parts of a chart.
• Edit the text. See Editing chart text.
• Change the border around the legend or hide the border. See Changing the look of a border in a chart..
• Modify the appearance of legend text. See Changing text font, sizes, and colors.
• Change the color and pattern within the border. See Changing colors and patterns in a chart..
• Reposition the legend. See Moving a chart part.



Details: Changing colors and patterns in a chart
Selecting a series
You can select a series from the InfoBox. Under "Properties for," select Series, then select the name of the series 
from the list on the Options panel. You can also select the series by clicking it. The InfoBox will update to reflect your 
selection.

Selecting colors
To select a color on the Lines & Colors panel of the InfoBox, click arrow beside any color box to display the color 
palette. When you click a different color, the color of the selected object changes.

Changing pattern colors
A pattern has two parts: the color of the pattern (such as dots or stripes), and the background color that appears 
behind the pattern. For example:

In the pattern settings, the top left square represents a transparent pattern. If you change a series to Transparent, you
will not be able to click it to select it. To select it, open the InfoBox and under Properties for, select Series. On the 
Options panel, select the transparent series.

{button ,AL(`H_LC_CHANGING_COLORS_STEPS',1)} Go to procedure



Changing colors and patterns in a chart
Use the InfoBox to change colors and patterns.
1. Choose Chart - Chart Properties.
2. Under Properties for, select the chart part you want to change. See details .
3. Click the Lines & Colors tab.

4. Under Interior, select the Pattern, Pattern color, and Background.
Tip To select a single object in a group, such as one bar, hold the CTRL key and click the bar.

{button ,AL(`H_LC_CHANGING_COLORS_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_COLORS_DETAILS;H_LC_CHANGING_STYLE_STEPS;H_LC_CHANGING_LINE_

STYLES_STEPS;H_LC_ADDING_3D_STEPS;',0)} See related topics



Details: Changing the look of a chart border
Removing a border
You can remove the line around a title, legend, note, or plot by setting the line Style to None in the InfoBox. When you
click the chart part, the selection handles will still appear so that you resize the chart part.

Troubleshooting
If no border line appears, be sure that you have selected both a Style and a Color for the line.

{button ,AL(`H_LC_CHANGING_FRAME_STEPS',1)} Go to procedure



Changing the look of a chart border
Changing lines around chart parts
You can change the line style, thickness, color, and patterns of chart parts.
1. Choose Chart, then the chart part (Title, Legend, Plot, Note, or Table) from the menu.
2. Click the Lines & Colors tab.

3. Under Interior, select a Pattern, Pattern color, and Background.
4. Under Line, select a Color, Width, and Style.

Changing the border around a chart
You can change the border surrounding the entire chart, and add a pattern to the border area.
1. Choose Chart - Chart Properties.
2. Under Properties for, select Chart.
3. Click the Lines & Colors tab.

4. Under Border, select the Style, Width, and Color.
5. Under Interior, select the Pattern, Pattern color, and Background.
6. Check "Same color as border" if you want to use the border color.

{button ,AL(`H_LC_CHANGING_FRAME_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_COLORS_DETAILS;H_LC_CHANGING_LINE_STYLES_STEPS;H_LC_COLORS_

PATTERNS_LINES_TEXT_OVER',0)} See related topics



Details: Changing line styles in a chart
You can change the line width, color, and style of these chart parts using the Lines & Colors panel of the InfoBox. 
Select the name of the chart part from the "Properties for" list at the top of the InfoBox.

• Border surrounding a chart. Select "Chart."
• Line surrounding a title. Select "Title."
• Line surrounding a note. Select "Note."
• Line surrounding a legend. Select "Legend."
• Chart plot. Select "Plot."
• Lines surrounding chart areas, bars, and pie slices. Select "Series."
• Lines in a scatter chart, any line chart, radar chart, or mixed chart. Select "Series."
• Grid lines in a number grid or data table under a chart. Select "Table." 

{button ,AL(`H_LC_CHANGING_LINE_STYLES_STEPS',1)} Go to procedure



Changing line styles in a chart
1. Choose Chart - Chart Properties.
2. Under Properties for, select the chart part containing the line you want to change.
3. Click the Lines & Colors tab.

4. Under Line, select the Color, Width, and Style.
Tip To hide a line, set the Style to None.

{button ,AL(`H_LC_CHANGING_LINE_STYLES_DETAILS',1)} See details
{button ,AL(`;H_LC_CHANGING_COLORS_STEPS;H_LC_CHANGING_MARKERS_STEPS',0)} See related topics



Overview: Chart colors, patterns, line and text styles
A new chart uses a standard set of colors, patterns, and line and text styles. You can easily customize a chart by 
selecting individual parts, such as bars or titles, then using the InfoBox to change their appearance.
You can change:

• Colors and patterns of solid objects, such as the background of a plot or individual bars or pie slices. See 
Changing colors and patterns in charts.

• Text, such as titles or axis names. See Changing text fonts, sizes, and colors in charts.
• Lines, such as lines in a line chart, the outline of bars, or a chart border. See Changing line styles in a chart.
• Numeric formats. See Changing numeric formats in a chart. 



Details: Changing the layout of multiple pies
The Options panel controls these options for multiple pies:

Slice direction
• Clockwise or counterclockwise. As you change the start angle, the pie slices will redraw in the direction you 

specify.
• Start angle. Click the arrows to incrementally change the start angle, or enter a value from 0 to 359.

Pie layout
• Automatic. The pies are displayed on the optimal number of lines.
• In n rows. You can specify the number of rows to use. This number may be automatically adjusted to insure a 

sensible layout.

Sort slices by size
• Unsorted. Slices are not sorted.
• Separately for each pie. Each pie is sorted using its slice values.
• Based on first pie. The order of the slices is determined by the first pie.
• Based on last pie. The order of the slices is determined by the last pie.

Scale pies
• Equally. All pies are the same size.
• By area. The size of the pies will vary depending on the totals of their data values.
• By height. On 3D pie charts, the height of the pies will vary depending on the values. 

{button ,AL(`H_LC_CHANGING_MULTI_PIE_LAYOUT_STEPS',1)} Go to procedure



Changing the layout of multiple pies
Multiple pies can be laid out using more than one row.
1. Choose Chart - Plot.
2. Click the Layout tab.
3. Under Pie layout, click "Automatic," or click "In n rows" and enter the number of rows to use.
4. (Optional) Under Sort slices by size, select an option.    See details.

{button ,AL(`H_LC_CHANGING_MULTI_PIE_LAYOUT_DETAILS',1)} See details
{button ,AL(`H_LC_Changing_multi_pie_steps;',0)} See related topics



Details: Changing the scaling of multiple pies
Using scaling options
Scale pies

• Equally. All pies are the same size.
• By area. The size of the pies will vary depending on the values.
• By height. For 3D pies, the height will vary depending on the values.

{button ,AL(`H_LC_CHANGING_MULTI_PIE_SCALING_STEPS',1)} Go to procedure



Changing the scaling of multiple pies
You can change the size of pies in a multiple pie chart so that pies with larger values appear larger.
1. Choose Chart - Plot.
2. Click the Layout tab.
3. Under "Scale pies," select an option.

{button ,AL(`H_LC_CHANGING_MULTI_PIE_SCALING_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_MULTI_PIE_LAYOUT_STEPS;',0)} See related topics



Details: Changing the start angle and direction for pie charts
Options
Slice direction

• Clockwise or counterclockwise. As you change the start angle, the pie slices will redraw in the direction you 
specify.

• Start angle. Click the arrows to incrementally change the start angle, or enter a value from 0 to 359.

{button ,AL(`H_LC_CHANGING_PIE_START_ANGLE_STEPS',1)} Go to procedure



Changing the start angle and direction for pie charts
1. Choose Chart - Plot.
2. Click the Layout tab.
3. Under Slice direction, click the clockwise or counterclockwise icon.
4. Under Start angle, select a value.

{button ,AL(`H_LC_CHANGING_PIE_START_ANGLE_DETAILS',1)} See details
{button ,AL(`H_LC_LC_INDEPENDENT_PIE_DATA_STEPS;H_LC_CHANGING_PIE_LABELS_STEPS;',0)} See 

related topics



Details: Using different slice labels for multiple pies
Using independent data
With pies that have independent data, the slice labels are stored in every other row:

Sales Expense
s

Phone sales 50 Magazine 
ads

10

Mailings 47 Seminars 15
Retail 20 Radio ads 12

Mailings 14
This data would create two independent pie charts:

• The pie "Sales" has three slices: Phone sales, Mailings, and Retail.
• The pie "Expenses" has four slices: Magazine ads, Seminars, Radio ads, and Mailings.

Pies with independent data cannot be sorted based on the first or last pie. The only sorting options are Unsorted or 
Separately for each pie.
When you specify "Use independent data," the legend does not display.

Adding labels and titles for multiple pies
Use the Edit Data window to add labels and titles. Choose Chart - Edit Data. Under Labels, enter the label text. Under
Pie Titles, enter title text. To display the pie labels, choose Chart - Pie Labels, click the Options tab, and check Show 
slice labels.

Changing an individual pie slice
You can select one slice of a pie and then make changes to it. In a pie using independent data, you can simply click 
the pie slice. (In a pie chart that does not use independent data, you must hold the CTRL key when you click the 
slice.) Use the Lines & Colors panel of the InfoBox to change colors and patterns of the selected slice.
Pies with independent data cannot be sorted based on the first or last pie. The only sorting options are Unsorted or 
Separately for each pie.

{button ,AL(`H_LC_INDEPENDENT_PIE_DATA_STEPS',1)} Go to procedure



Using different slice labels for multiple pies
In a chart with multiple pies, you can use independent data for each pie.
1. Select a pie chart with multiple pies.
2. Choose Chart - Pie.
3. Click the Data tab.
4. Check    "Use independent data."

{button ,AL(`H_LC_INDEPENDENT_PIE_DATA_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_PIE_LABELS_STEPS;',0)} See related topics



Overview: Pie charts
Pie charts show data for each series in a separate pie, with each slice of the pie representing a data value.

Each pie represents 100% of the values for the series. A single pie chart has one pie, and shows the data for one 
series. A multiple pie chart shows a separate pie for each series.

The data in multiple pies can be synchronized or independent:
• For synchronized data, the slices in each pie represent the same types of values. For example, if you are tracking

sales figures for products over three years, the same color slice in each pie would show the sales for each 
product sold.

• For independent data, each series produces a separate pie. For example, you could use one chart to show profits
and one to show expenses. See Using independent data for multiple pies.

Changes you can make to pies and slices
In pie charts, you can:

• Change the direction of the pie slices. See Changing the start angle and direction for pie charts.
• Change the layout and scaling of multiple pies. See Changing the layout of multiple pies.
• Change the look of 3D effects. See Changing 3D for pie charts.

For individual pie slices, you can:
• Combine and sort the slices. See Combining pie slices    and Sorting pie slices by size.
• Change the color or line style of a slice. See Changing pie slice color, line style, and fill.
• Move a slice away from the center of the pie. See Exploding pie slices.



Details: Showing pie titles and totals
You can create a pie title for each pie. If you are using the Edit Data window, enter the title in the Pie Titles area. You 
can also create a chart title for the entire chart. See Adding titles to a chart.

Changing the appearance of text
You can change the font, color, and style of the title and total using the Lines & Colors panel of the InfoBox. Select 
the title or total, click the Lines & Colors tab, and change the options.

{button ,AL(`H_LC_PIE_TOTALS_STEPS',1)} Go to procedure



Showing pie titles and totals
1. Choose Chart - Pie Titles.
2. Click the Options tab.
3. Check "Show title" and "Show Pie total."
4. Under "Position," select Above pie or Below pie.
Tip You can edit the title by double-clicking the text and entering new text.

{button ,AL(`H_LC_PIE_TOTALS_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_PIE_LABELS_STEPS;',0)} See related topics



Details: Changing the chart orientation
Using the orientation and dimension icons with a chart type
The icons on the Type panel will vary depending on the chart type. Use these icons to control: 

• Chart orientation. Any bar chart can be positioned vertically or horizontally. 
• Chart dimension. You can create 3D or with-depth charts for most chart types. Note that 3D charts can be rotated,

and with-depth charts cannot be rotated.
• Multiple pie charts. 

{button ,AL(`H_LC_CHANGING_ORIENTATION_STEPS',1)} Go to procedure



Changing the chart orientation
You can change the vertical and horizontal orientation of any bar chart.
1. Select a chart.
2. Choose Chart - Chart Type.
3. Click the Type tab.
4. Click the icon representing the horizontal or vertical orientation you want to use.

{button ,AL(`H_LC_CHANGING_ORIENTATION_DETAILS',1)} See details
{button ,AL(`H_LC_SIZING_CHART_STEPS;',0)} See related topics



Details: Changing to a different chart type
Using the Type panel icons
Once you select a chart type, the icons at the right side of the panel will change to the appropriate icons for that type. 
Click an icon to select it. These icons control the orientation (horizontal, vertical) and the dimension (3D or with-
depth) for the chart type. Not all options are available for all chart types.

Changing to pie charts
If you have multiple series in a bar, line, or area chart, and you want to chart all the series as pies, be sure to click the
multiple pies icon on the righthand side of the Type panel. If you click the single-pie icon, only the first series will be 
charted.

Matching the chart type to the data
Different chart types convey different messages. To emphasize your message, select the best chart type for the 
purpose. See Overview: Chart types.

{button ,AL(`H_LC_TYPES_CHANGING_STEPS',1)} Go to procedure



Changing to a different chart type
You can change to another chart type, dimension (2D, 3D, and with-depth), and orientation.
1. Select a chart.
2. Choose Chart - Chart Type.
3. Click the Type tab.
4. Under Chart type, select a chart type.
5. Click an icon at the right side of the Type panel.
Tip The orientation icons will vary depending on the chart type you select.

{button ,AL(`H_LC_TYPES_CHANGING_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_PLOT_LOOK_STEPS;',0)} See related topics



Overview: Chart types
Different chart types convey different messages. To emphasize your message, choose the best chart type for the 
purpose. See Designing effective charts.

Working with chart types
You can easily change from one chart type to another using the InfoBox. Choose Chart - Chart Type from the Chart 
menu to display the InfoBox, and click the Type tab. Under Type, select a chart type. From the icons at the right side 
of the panel, select the display characteristics you want for the chart. These options may include horizontal and 
vertical, or 3D and with-depth display.

Area charts
Area charts track data over time, and present the data as broad trends, rather than focusing on dividual data points. 
See Designing area charts.
In addition to a two-dimensional area chart, you can also create:

• 3D area. You can rotate a 3D chart. Click the 3D tab on the InfoBox to change the elevation and rotation.
• Area with-depth. A with-depth chart gives the appearance of depth, but cannot be rotated.

Bar charts
Bar charts also present data over a period of time, with an emphasis on individual data points.
Some of the bar charts you can create include:

• Stacked bar charts. See Designing stacked bar charts.
• Vertical bar charts. See Designing vertical bar charts.

High-Low-Close-Open (HLCO) charts 
HLCO chart is often used for stock market reports. See Designing High-Low-Close-Open (HLCO) charts.

Line charts 
Line charts are a good choice when you have a lot of data points, where the slope of the line indicates a general 
trend. See Designing line charts.

Mixed charts
In one chart, you can specify a combination of bar, line, or area for the series. See Designing mixed charts.

Pie charts
Pie charts show the relationship of a part to the whole. See Designing pie charts.

Scatter charts
A scatter chart is helpful when you want to show if there is a correlation between two variables. Scatter charts have 
two numeric axes, which can be linear or logarithmic.See Designing scatter (XY) charts.

Radar charts
See Designing radar charts .



Details: Displaying pie slice labels
Using pie slice labels
You can select up to three labels for each pie slice:

• Show value labels displays the actual data value.
• Show percent labels displays the percentage of each slice to the whole.
• Show slice labels displays the label text. You can enter label text manually in the Edit Data window, or import the 

text 
Limiting the number of labels that you display on a chart can make it more legible. Instead of displaying percent, 
value, and slice labels on a chart, select only one or two for more impact.

{button ,AL(`H_LC_CHANGING_PIE_LABELS_STEPS',1)} Go to procedure



Displaying pie slice labels
You can display value, percent and slice labels for a pie chart.
1. Choose Chart - Pie Labels.
2. Click the Options tab.
3. Check one or more of the Show boxes.
4. (Optional) Under Position, select the position where the label is displayed.

{button ,AL(`H_LC_CHANGING_PIE_LABELS_DETAILS',1)} See details
{button ,AL(`H_LC_EXPLODING_PIE_SLICES_STEPS;H_LC_INDEPENDENT_PIE_DATA_STEPS;',0)} See related 

topics



Details: Changing pie slice color, line style, and fill
Combining small slices into a single slice
Consider combining several small slices into one slice when the pie chart has many slices. See Combining pie slices.

Making good design choices
By default, many design choices are already made for you, such as the colors, and the maximum number of 
individual slices that are displayed. You can also make your own design decisions:

• Use six or fewer slices.
• Limit the number of patterns in a chart.
• Try exploding a slice for emphasis.
• Consider how the chart will be distributed. A color chart will look different when printed on a black-and-white 

printer.
• Eliminate small or insignificant slices, or combine them into one slice.

{button ,AL(`H_LC_CHANGING_PIE_SLICES_STEPS',1)} Go to procedure



Changing pie slice color, line style, and fill
1. Choose Chart - Slices.
2. Click a pie slice.

To select a slice of a single pie in a multiple pie chart, hold the CTRL key and click the slice.
3. Click the Lines & Color tab.

4. Under Interior, select a Pattern, Pattern color, and Background for the interior of the slice.
5. Under Line, select a Color, Width, and Style to change all the lines in the pies.

{button ,AL(`H_LC_CHANGING_PIE_SLICES_DETAILS',1)} See details
{button ,AL(`H_LC_SELECTING_PIES_STEPS;',0)} See related topics



Details: Combining pie slices
Maximum slices in a pie
Although the maximum possible number of slices in a pie is forty, you should consider using a smaller number of 
slices for legibility.

Controlling how slices are displayed
You can specify other slice options using the InfoBox. Choose Chart - Chart Properties to display the InfoBox. Under 
Properties for, select Chart, then click the Layout tab. On this panel, you can specify:

• Clockwise or counterclockwise direction for the slices.
• Angle (from 0 to 359) at which the slices start.
• Sort slices by size.

You can use these options to situate the most important slice at the upper right part of the chart.

{button ,AL(`H_LC_COMBINING_SLICES_STEPS',1)} Go to procedure



Combining pie slices
You can combine the smallest pie slices into one slice to make a chart more legible.
1. Choose Chart - Pie.
2. Click the Data tab.
3. Under "Combine additional slices into one, if there are more than...", enter a number.
4. (Optional) Under Label, enter a label name for the combined slice.

{button ,AL(`H_LC_COMBINING_SLICES_DETAILS',1)} See details
{button ,AL(`H_LC_EXPLODING_PIE_SLICES_STEPS;H_LC_CHANGING_PIE_SLICES_STEPS;H_LC_CHANGIN

G_PIE_LABELS_STEPS;',0)} See related topics



Details: Exploding pie slices
Exploding individual pie slices
To move just one pie slice, click the slice and drag it out from the center.

Emphasizing pie slices
Another way to make a slice of data stand out is to change the color or pattern of a slice. See Changing pie slice 
color, fill, and line style.

{button ,AL(`H_LC_EXPLODING_PIE_SLICES_STEPS',1)} Go to procedure



Exploding pie slices
You can move out one slice or all slices from the center of a pie chart.

To explode one slice
1. Select a slice.

• To select one slice in a single pie chart, click the slice.
• To select one slice in a multiple pie chart, press the CTRL key and click the slice.

2. Drag the slice away from the center of the chart.

To explode or reassemble all the slices
1. Choose Chart - Chart Properties.
2. Under Properties for, select Plot.
3. Click the Layout tab.
4. Under Explode slices %, enter a number from 100 (fully exploded) to 0 (slices not exploded).

{button ,AL(`H_LC_EXPLODING_PIE_SLICES_DETAILS',1)} See details
{button ,AL(`H_LC_COMBINING_SLICES_STEPS;H_LC_3D_PIES_CHANGE_STEPS;',0)} See related topics



Details: Sorting pie slices by size
Other sorting changes 
You can change the direction in which the pie slices are sorted. Under Slice direction, choose clockwise or 
counterclockwise. You can also choose the angle at which the sorting starts. Under Start angle, enter a value 
between 0 and 360.

{button ,AL(`H_LC_REARRANGING_SLICES_STEPS',1)} Go to procedure



Sorting pie slices by size
1. Choose Chart - Plot.
2. Click the Layout tab.
3. Do one of the following:

• For a single pie, check "Sort slices by size."
• For multiple pie charts, under "Sort slices by size" select a sorting option. See details .

{button ,AL(`H_LC_REARRANGING_SLICES_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_MULTI_PIE_LAYOUT_STEPS;H_LC_CHANGING_PIE_START_ANGLE_STEPS;',0

)} See related topics



Changing the look of a chart plot
You can change the color and    pattern of the entire plot of a bar, line, or area chart.
1. Select the chart.
2. Choose Chart - Plot.
3. Click the Lines & Colors tab.

4. Under Interior, select a Pattern, Pattern color, and Background.
5. Under Line, select a Color, Width, or Style for the line around the plot.

{button ,AL(`H_LC_CHANGING_COLORS_STEPS;',0)} See related topics



Changing the shape of a radar chart plot
By default, radar charts use a circular boundary for the plot. You can change the boundary to a polygonal shape, with 
one corner of the polygon at each axis.
1. Select a radar chart.
2. Choose Chart - Plot.
3. Click the Options tab. 
4. Check "Use polygonal plot boundary."

{button ,AL(`H_LC_CHANGING_PLOT_LOOK_STEPS;H_LC_SCALING_RADAR_AXES_STEPS;',0)} See related 
topics



Overview: Chart plot
The plot is the area in the chart that surrounds the data. The plot does not include other text, such as the title, axis 
labels, or a note. All chart types have a plot, except pie charts.

There are several ways to select the plot:
• Click the plot border.
• Click within the plot border (without clicking any other chart part).
• Select it from the "Properties of" list in the InfoBox (Chart - Chart Properties).

Once the plot is selected, you can: 
• Change the color and pattern of the plot. See Changing the look of the plot.
• Move the plot. See Moving a chart part.
• Resize the plot. See Resizing a chart or chart part.



Details: Using an existing chart style
Chart styles you create
You can create your own chart styles, name them, and use them when you create new charts. See Creating a new 
chart style.

Deleting chart styles
You can remove a chart style by deleting it from the directory where it is saved.

Changing a chart style
You can make changes to a chart style and then save it using a new name or the same name. See Creating and 
editing a chart style.

{button ,AL(`H_LC_CHANGING_STYLE_STEPS',1)} Go to procedure



Using an existing chart style
1. Choose Chart - Chart Style - Apply.
2. Click the Styles tab.

3. Select a chart style.
4. Click Apply.
Tip If you have chart styles saved in another directory, choose Chart - Chart Style - Change Path, select the directory,
then return to this panel to select a style.

{button ,AL(`H_LC_CHANGING_STYLE_DETAILS',1)} See details
{button ,AL(`H_LC_CREATING_STYLE_STEPS;H_LC_EDITING_STYLE_STEPS;',0)} See related topics



Details: Creating and editing a chart style
The changes you make to a chart style take effect the next time you create a chart. The changes do not affect charts 
that you already created with the old style.

Saving a chart style to the same directory
To access all the styles easily, keep them in the same directory with the "basic.cl" style. All the styles will then appear 
in the Chart styles list. If you save the styles in different directories, you will have to use the Chart - Chart Style - 
Change Path command to access the other directory.

Deleting a chart style
You can delete a chart style from the directory where it is saved. 

{button ,AL(`H_LC_CREATING_STYLE_STEPS',1)} Go to procedure



Creating and editing a chart style
To create a new chart style
1. Select the chart you want to use as a template.
2. Choose Chart - Chart Style - Create.
3. Under Preview of New Style, check to see that this is the chart you want. 
4. Click OK to accept the chart.
5. Enter a style name.
6. Click OK.

To edit a chart style
If the preview chart is not what you want for the chart style, you can edit it.
1. Click Cancel.
2. Choose Chart - Chart Properties.
3. Edit the chart.

• Under Properties for, select the chart part you want to change.
• Click a tab (such as Lines & Colors) and change the options for the selected part.

4. Proceed from step 2 above.

{button ,AL(`H_LC_CREATING_STYLE_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_STYLE_STEPS;',0)} See related topics



Details: Setting the default chart type and style
Choosing a different chart style
When you create a chart, one chart style (basic.cl) is provided for you. You can also create your own chart styles, 
name them, and use them when you create new charts. Using a chart style provides a uniform look to your charts. 
See Creating and editing a chart style.

Changing chart types
You can easily change from one chart type to another without having to reset the default chart type. Choose Chart - 
Chart Type to open the InfoBox. Then click the Type tab, and select a different chart type from the Chart type list.

{button ,AL(`H_LC_STYLES_DEFAULT_STEPS',1)} Go to procedure



Setting the default chart type and style
You can specify a default chart type and style. The settings take effect the next time you create a chart.
1. Choose Chart - Chart Styles - Set Default Chart.
2. Under Select a chart type, select the chart type and the appropriate icon (for example, 2D or 3D).
3. Under Select a chart style, select the style file.
4. Click OK.

{button ,AL(`H_LC_STYLES_DEFAULT_DETAILS',1)} See details
{button ,AL(`H_LC_CHANGING_STYLE_STEPS;',0)} See related topics



Overview: Chart styles
A chart style is a named set of chart attribute settings, such as colors, fonts, and line styles. Using a chart style 
means that many design decisions are already made for you. A chart style makes it easier to create charts with a 
consistent look.

Using a chart style
When you change from one chart style to another, the appearance of the current chart changes. The colors, patterns,
text styles, and line styles will probably change, depending on the style. The placement of titles, size of the chart, and
the parts that appear may also change.
You can specify a chart style in one of two ways:

• Use the chart style (basic.cl) that is provided. Look for this style name when you are creating a new chart or using
the Style panel of the InfoBox. See Using an existing chart style.

• Create your own style based on an existing style. See Creating and editing a chart style.



Details: Copying a chart between applications
Editing a copied chart
Any changes you make to a copied chart do not affect the original chart. If the data for the chart is linked to a 
worksheet, changes in the data will update both the original and the copy.
A chart copied into Approach or Notes ViP cannot be edited. It is a picture of a chart and does not change even if the 
underlying data changes.

{button ,AL(`H_LC_COPYING_CHART_STEPS',1)} Go to procedure
{button ,AL(`',0)} See related topics



Copying a chart between applications
You can copy a chart from one Lotus application to another.
1. Select a chart.
2. Choose Edit - Copy.
3. Open the document where you want to copy the chart. 
4. Choose Edit - Paste.

{button ,AL(`H_LC_COPYING_CHART_DETAILS',1)} See details



Emphasizing a data point
You can select and change one area, bar, or grid line to emphasize one data point.
1. Choose Chart - Chart Properties.
2. Press CTRL and click the part of the chart you want to change.
3. Click the Lines & Colors tab.

4. Under Interior, select a Pattern, Pattern color, and Background.

{button ,AL(`H_LC_SELECT_OVER;',0)} See related topics



Details: Moving a chart part
To reposition the title, legend, or note, use the mouse or the layout buttons in the InfoBox.

• Mouse. Click the part and drag it to a new location within the chart.
• Layout buttons. Open the InfoBox, select the part you want to move, and click the Options tab. Under Position, 

click the button that corresponds to the new position. For a legend, you can specify whether it should be inside or 
outside the plot area. 

{button ,AL(`',0)} See related topics



Moving a chart part
You can move a chart, legend, title, note, pie, or plot.
1. Click and hold the mouse on the part you want to move.
2. Drag the part to the new location, then release the mouse button.
Tip You can also move a legend or title using the Position buttons in the InfoBox. See details.

{button ,AL(`H_LC_MOVING_CHART_DETAILS',1)} See details
{button ,AL(`H_LC_SIZING_CHART_STEPS;H_LC_SELECTING_INFOBOX_STEPS;H_LC_SELECTING_MOUSE_

STEPS;',0)} See related topics



Overview: Resizing, moving, and copying a chart
You can resize, move, and copy a chart.

Resizing
Some resizing happens automatically, for instance, when you add a table below a chart or add pies to a multiple pie 
chart. But you can also make the chart the size you want. See Resizing a chart or chart part. 

Moving 
In a chart, you can:

• Move the entire chart by clicking it and then dragging it to a new location.
• Move the title, legend, note, or plot within the chart. See Moving a chart part.

Copying
You can copy a chart from one application and paste it in another. You can also copy a chart from one page to 
another within the same application. See Copying a chart between applications.



Details: Selecting chart parts using the InfoBox
Determining what is selected
When an object is selected, selection handles (small boxes) appear around the object.

Selecting hidden chart parts
Use the InfoBox to display a hidden chart part, such as a legend or a series. Open the InfoBox (Chart - Chart 
Properties) and select the chart part from the "Properties for" list at the top of the InfoBox. Click the Layout tab, then 
check the Show box.
You cannot select hidden parts using the mouse.

{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS',1)} Go to procedure



Selecting chart parts using the InfoBox
Use the InfoBox to select the part of the chart you want to work with.
1. Click a chart to select it. 
2. Choose Chart - Chart Properties.
3. Under Properties for, select a part.
Tip To modify the selected part, choose from the options on the InfoBox panels. Click a tab to display a panel, such 
as Lines & Colors. 

{button ,AL(`H_LC_SELECTING_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_LC_SELECTING_MOUSE_STEPS;H_LC_SELECTING_PIES_STEPS;H_LC_SELECTING_TABLES

_STEPS;',0)} See related topics



Details: Selecting chart parts with the mouse
Determining what is selected
Handles (small boxes) appear around the selected object.

Selecting one in a set
To select a single item from a set, hold down CTRL when you click the mouse.
On line, bar, area, or mixed charts, you can select:

• Individual bar, area, or line segment
• Individual cell in a table
• Individual major grid line (x-axis, y-axis, 2nd y-axis)

On a pie chart, you can select:
• Individual pie slices
• Individual pie slice labels

Selecting in a 3D chart
You can select the same way that you select parts of a 2D chart. In addition, you can select:

• Platform left face or right face
• Left back wall or right back wall
• Floor

See Changing the 3D chart platform.

Selecting hidden chart parts
Use the InfoBox to display a hidden chart part, such as a legend, series, or data table. Open the InfoBox (Chart - 
Chart Properties). Under "Properties for," select the part you want to show. Click the Options tab, then check the 
Show box. You cannot select hidden chart parts using the mouse.

{button ,AL(`H_LC_SELECTING_MOUSE_STEPS',1)} Go to procedure
{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS;H_LC_SELECTING_TABLES_STEPS;H_LC_SELECTING_PIE

S_STEPS;',0)} See related topics



Selecting chart parts with the mouse 
You can select:

• Entire chart. Click the chart border or just outside the plot.
• Pie. Click the center of the pie.
• Part of a chart, such as a series. Click the part you want to select.
• Chart parts with text, such as the legend. Click the border around the part to select the part itself, or click the text 

to select the text.
• One of a series of parts, such as one bar, one line segment, or a pie slice. Point to the part, hold the CTRL key, 

and then click the mouse.

{button ,AL(`H_LC_SELECTING_MOUSE_DETAILS',1)} See details
{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS;',0)} See related topics



Details: Selecting in a pie chart
Working with pie charts with multiple pies
A pie chart displays each series in a separate pie. If you have multiple series, you can create multiple pies. 

You can also create pie charts with independent data.

Working with independent data
If you have multiple series, you can make each of the series independent of the other series. In this example, the 
data slices in each pie represent different information, unlike those in the multiple pie chart shown above.

Another way to produce separate pies is to create each pie from individual data series but display them all on the 
same page. You can create additional pie charts on the same page or move or copy a pie chart from another page or 
application.

Selecting a pie using the InfoBox
You can use the InfoBox to select one pie from multiple pies in the same chart. Choose Chart - Chart Properties to 
open the InfoBox. Under "Properties for," select Pie, then click the Data tab. In the drop-down list, select the pie. 

{button ,AL(`H_LC_SELECTING_PIES_STEPS',1)} Go to procedure
{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS;H_LC_PIE_TOTALS_STEPS;',0)} See related topics



Selecting in a pie chart
You can use the mouse or InfoBox to select parts of a pie chart.

To select with the InfoBox
1. Choose Chart - Chart Properties.
2. Under Properties for, select a chart part.

To select with the mouse
• For one pie chart in a multiple pie chart, click the center of the pie.
• For a chart with one pie, click outside the pie (useful when you want to resize or move the pie).
• For one slice in a single pie, click the slice. (In a pie chart with multiple pies, clicking one slice selects    the 

corresponding slice in each of the pies.)
• For one slice in a pie chart with multiple pies, hold the CTRL key and click the slice.
• For one slice in a pie chart with multiple pies that uses independent data, click the slice. See details .

{button ,AL(`H_LC_SELECTING_PIES_DETAILS',1)} See details
{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS;H_LC_SELECTING_MOUSE_STEPS;',0)} See related topics



Details: Selecting in a chart table or number grid
You can use the mouse to resize a number grid, but not a data table. The frame of a data table is always aligned with 
the plot frame of the chart.
For vertical 2D charts (bar, stacked bar, area, line, XY, HLCO, mixed), the columns of data in the data table are 
aligned with the x-axis tick marks.

{button ,AL(`H_LC_SELECTING_TABLES_STEPS',1)} Go to procedure



Selecting in a chart table or number grid
1. Choose Chart - Table.
2. Click the Options tab.
3. Check the options you want:

• Show row headers (Number grid and table)
• Show column headers (Number grid and table)
• Show row totals (Number grid only)
• Show column totals (Number grid only)
• (Optional) Under Column totals label, enter text.

To hide or display a series
1. Select the series from the drop-down list.
2. Check the options you want.

• Show series in table (Number grid and table)
• Show series in chart (Table only)

Tip To display a table under a chart, check Show data table.

{button ,AL(`H_LC_SELECTING_TABLES_DETAILS',1)} See details
{button ,AL(`H_LC_SELECTING_INFOBOX_STEPS;H_LC_ADDING_TABLE_UNDER_STEPS;',0)} See related 

topics



Overview: Selecting in a chart
The first step in changing a chart is to select what you want to work with, such as a legend or axis. You can make a 
selection using the InfoBox or the mouse. Selection handles (small squares) appear around the selected chart or 
chart part.

Selecting with the InfoBox
The InfoBox (Chart - Chart Properties) provides easy access to any part of a chart. 

• To open the InfoBox, choose Chart - Chart Properties. 
• To select a chart part, click the "Properties for" list at the top of the InfoBox and make a selection.
• To open the InfoBox from the chart, double-click a chart or part of a chart. The InfoBox opens to the correct panel 

of options for the selected part.
Tip You can keep the InfoBox open while you are working on a chart. The InfoBox is context-sensitive; as you click 
different parts of a chart, the InfoBox updates.

Selecting with the mouse
To use the mouse to make a chart selection, click the part of the chart you want. Selection handles (small squares) 
appear around the part. Notice that the mouse pointer changes as you move it from text to an axis line. See Selecting
chart parts with the mouse.
For more information about chart tables and pie charts, see Selecting in a chart table. and Selecting in a pie chart.

Clicking in the right place
The mouse pointer changes shape as you move it around the chart, providing a visual cue about what it points to. For
instance, if you move the mouse pointer to text on the title, a small "A" appears.

Working with a selection
Once you have selected a chart or part of a chart, you can: 

• Change colors, patterns, and styles. See Changing colors and patterns in a chart.
• Modify text. See Changing text fonts, sizes, and colors in a chart    and Editing chart text.
• Resize, move, or copy a chart. See Overview: Resizing, moving, and copying a chart.



Details: Resizing a chart or chart part
Resizing guidelines
You can resize in one direction, or both directions at once: 

• To resize in one direction, click the selection handle in the middle of the box (top, bottom, left, or right) and drag to
the dimensions you want.

• To resize both the height and width at one time, click any one of the corner selection handles, and drag to the 
dimensions you want.

Resizing text
Use the InfoBox to change the font size. See Changing text fonts, sizes, and colors in a chart.

Changing line thickness
Use the InfoBox to change the line width. See Changing line styles in a chart..

{button ,AL(`H_LC_SIZING_CHART_STEPS',1)} Go to procedure



Resizing a chart or chart part
To change the size of a chart, plot, legend, title, or note, use the mouse.
1. Click the part you want to resize. Selection handles appear around the selected part.
2. Move the mouse pointer to point at a selection handle. The mouse pointer changes to a two-headed arrow shape.
3. Drag the selection handle to resize the part.
Tip To resize other parts, such as text or line thickness, use the InfoBox. See details.

{button ,AL(`H_LC_SIZING_CHART_DETAILS',1)} See details
{button ,AL(`H_LC_MOVING_CHART_STEPS;H_LC_SELECTING_INFOBOX_STEPS;',0)} See related topics



Overview: Creating a chart in Word Pro
In Word Pro, you can create charts in your document using the Create - Chart command.
Once you create a chart, you can customize it. You can:

• Add a title or subtitle. See Adding titles to a chart .
• Change colors and patterns. See Changing colors and patterns in a chart .
• Change the appearance of the text. See Changing text fonts, sizes, and colors in a chart. 
• Change the chart type. See Changing to a different chart type.

Learning more about Word Pro
For more information about Word Pro, choose Help - Help Topics, click the Index tab, and choose a topic from the 
Help Index.



Overview: Creating a chart in Approach
In Approach, you use the Chart Assistant to create a chart, using fields and crosstabs in the current database to 
provide data.

Using and modifying a chart
Once you create a chart, you can customize it. You can: 

• Add a title or subtitle. See Adding titles to a chart .
• Change colors and patterns. See Changing colors and patterns in a chart .
• Change the appearance of the text. See Changing text fonts, sizes, and colors in a chart. 
• Change the chart type. See Changing to a different chart type .

Learning more about Approach
For more information about Approach, choose Help - Help Topics, click the Index tab, and choose a topic from the 
Help Index.



Overview: Creating a chart in Freelance Graphics
You can create a chart as part of a Freelance Graphics presentation. There are three parts to creating a chart: 

Open the Create Chart dialog box
The Create Chart dialog box allows you to select a chart type, chart style, and SmartMaster colors. You can get to the
Create Chart dialog box in one of two ways:

• Choose Create - Chart from the menu.
• Choose any SmartMaster page layout that includes a chart, then click the Click here block.

See Create Chart dialog box.

Enter data in the chart
You can enter data by: 

• Manually typing data into the Edit Data window. See Adding data to a chart by typing .
• Importing data from a worksheet or file. See Adding data to a chart from a worksheet or file .

Use and modify a chart
Once you create a chart, you can customize it. You can: 

• Add a title or subtitle. See Adding titles to a chart .
• Change colors and patterns. See Changing colors and patterns in a chart .
• Change the appearance of the text. See Changing text fonts, sizes, and colors in a chart. 
• Change the chart type. See Changing to a different chart type .

Learning more about Freelance Graphics
For more information about Freelance Graphics, choose Help - Help Topics, click the Index tab, and choose a topic 
from the Help Index.



Create Chart dialog box
Use this dialog box to add a chart to your document. You can specify the chart type and optional chart style.

Choose a task 
Changing to a different chart type 
Using an existing chart style 



Set Default Chart dialog box
Use this dialog box to change the default chart type and style. The new settings take effect the next time you create a
chart.

Choose a task
Setting the default chart type and style
Creating and editing a chart style 



Edit Data dialog box
Use this dialog box to manually enter and edit data, chart titles, axis titles, and a chart note. To include imported data,
click the Import Data button to display the Edit Links dialog box.

Choose a task
Modifying typed or copied chart data 
Adding titles to a chart 
Adding a note to a chart 
Adding axis titles and subtitles
Linking chart data to a range 
Linking chart text to a range



Setting styles in charts
Use Styles to create a chart style or specify the default style to use when creating new charts.

Choose a task
Creating a new chart style
Setting the default style 



Open and Save dialog box
Use this dialog box to open a chart style file, to save a new chart style file, or to change the path to another directory 
for a chart style.

Choose a task
Creating and editing a chart style 
Setting the default chart type and style 



Setting properties for pie chart data
Use the Data panel for Pies properties to combine small pie slices into one labeled slice. For multiple pies, you can 
specify whether each pie uses independent data.

Choose a task
Combining pie slices 
Using independent data for multiple pies 



Details: Deleting a chart
Other ways to delete
Select the chart you want to delete, then do either of the following:

• Choose Edit - Clear.
• Click the Delete icon in the SmartIcons bar.

Troubleshooting
If you cannot delete the chart, be sure you have the entire chart selected, and not just the chart plot. Click outside the
plot area to select the entire chart. 

{button ,AL(`H_LC_DELETING_CHART_STEPS',1)} Go to procedure



Deleting a chart
You can permanently remove a chart from a document. 
1. Select the chart you want to delete.
2. Press DELETE.
Tip If Undo is available, you can immediately choose Edit - Undo to retrieve the deleted chart.

{button ,AL(`H_LC_DELETING_CHART_DETAILS',1)} See details
{button ,AL(`H_LC_MOVING_CHART_STEPS;H_LC_SIZING_CHART_STEPS;H_LC_COPYING_CHART_STEPS;',

0)} See related topics



Details: Deleting chart data
Troubleshooting
If Undo is available, choose Undo to retrieve the deleted chart data.

Deleting linked data
If you delete data in the source application and the chart is linked, the data in the chart will be updated.

Hiding chart data
An alternative to deleting data is to hide it. Hidden data does not appear in the chart, but can be easily redisplayed 
later. To hide a series, use the InfoBox. Choose Chart - Series, then click the Options tab. Select a series from the list
and deselect the Show box. See Hiding and showing chart data.

{button ,AL(`H_LC_DELETING_SERIES_FILE_STEPS',1)} Go to procedure



Deleting chart data
You can permanently delete a series, pie, or pie slice from a chart. 
1. Select the data you want to delete. 
2. Press DELETE.
Note Deleting data on the chart does not delete the data in the original source.

{button ,AL(`H_LC_DELETING_SERIES_FILE_DETAILS',1)} See details
{button ,AL(`H_LC_HIDE_SHOW_DATA_STEPS;H_LC_HIDING_COMPONENTS_STEPS;',0)} See related topics



Details: Hiding and showing chart data
Showing hidden lines, grids, or borders
To hide lines, such as grid lines or border, change the line style to "None" on the Lines & Colors tab of the InfoBox. To
redisplay a line, open the InfoBox, select the line part from the "Properties for" list, and select a line style and color on
the Lines & Colors tab. 

Troubleshooting
If you do not see the "Show" box you expected, check to be sure that you have the correct chart data selected. To 
change the chart selection, click the part in the chart, or select it from the "Properties for" list in the InfoBox. 
Undo. If the Edit - Undo command is available, you can use it to reverse the effect of the last action.

Using the chart data table to hide a series
You can hide a series using the chart data table. To display the data table, choose Chart - Table and click the Options 
tab. Check the "Show data table" box. Select the series you want to hide from the drop-down list. 

• To hide the series in the chart, deselect "Show series in chart."
• To hide the series in the table, deselect "Show series in table."

{button ,AL(`H_LC_HIDE_SHOW_DATA_STEPS',1)} Go to procedure



Hiding and showing chart data
You can hide or show a series, a pie, or pie slice. The data remains in the chart but does not display or print.
1. Choose Chart - Series.
2. Click the Options tab.
3. From the drop-down list, select the series you want to hide or show.
4. Do one of the following:

• To hide, deselect the "Show" box.
• To show, check the "Show" box.

Tip The "Show" text varies depending on what is selected. For example, if you select a pie slice, the check box will 
read "Show slice."

{button ,AL(`H_LC_HIDE_SHOW_DATA_DETAILS',1)} See details
{button ,AL(`H_LC_DELETING_SERIES_FILE_STEPS;H_LC_ADDING_DATA_123_STEPS;H_LC_ADDING_DATA_

TYPING_STEPS;',0)} See related topics



Details: Hiding and showing parts of a chart
Selecting chart parts from the Properties for list
To select a part, open the InfoBox (Chart - Chart Properties). Click the "Properties for" list    that appears at the top of 
the InfoBox. Click the name of the chart part to select it.

Repositioning parts of a chart
You can easily reposition a chart title, legend, or note.

• To move using the mouse, click the title, legend, or note, and drag it to a new position.
• To move using the InfoBox, choose the chart part under Properties for (Title, Legend, or Note). Click the Options 

tab. Click one of the Position settings.

{button ,AL(`H_LC_HIDING_COMPONENTS_STEPS',1)} Go to procedure



Hiding and showing parts of a chart
Use the InfoBox to control which parts are hidden and which parts are displayed. Hidden chart parts do not display or 
print.
1. Click a chart to select it.
2. Choose Chart - Chart Properties. 
3. Under Properties for, select the chart part you want to hide or show.
4. Click the Options tab.
5. Do one of the following:

• To hide, deselect the "Show" box.
• To show, check the "Show" box.

Tip The "Show" text varies depending on what chart part is selected. For example, if you select the legend, the check
box will read "Show legend."

{button ,AL(`H_LC_HIDING_COMPONENTS_DETAILS',1)} See details
{button ,AL(`H_LC_DELETING_CHART_STEPS;',0)} See related topics



Overview: Hiding, showing, and deleting in a chart
Comparing hide and delete
You can control which parts of a chart are displayed by hiding or deleting. Both methods alter the chart.    Hiding is 
temporary. The hidden parts still exist, but they do not appear when the chart is printed or displayed. Deleting is 
permanent, though it can be immediately reversed if Undo is available. 

Hiding and showing information in a chart
Use the InfoBox to specify what parts appear on a chart. You can:

• Hide part of a chart. For example, you may choose not to show a title if you want more room for your data.    You 
can also easily redisplay a hidden part, such as series labels or the legend. See Hiding and showing parts of a 
chart. 

• Hide data, such as a series, pie, or pie slice. You can emphasize more important data by hiding extraneous data. 
The original chart is not affected. By hiding rather than deleting, a single chart can be used for different purposes. 
See Hiding and showing chart data. 

Deleting information in a chart
Deleting parts of a chart or chart data is a permanent method of altering a chart. Although deleted data no longer 
appears in the chart, the data is not deleted from the original source. See Deleting chart data .



Details: Entering data using Fill by Example
Specifying a format
You can use any of the following formats:

• January, February, March, etc.
• Jan, Feb, Mar, or JAN, FEB, MAR, etc.
• Sunday, Monday, Tuesday, or Sun, Mon, Tue, etc.
• Q1, Q2, Q3, Q4, or First Quarter, Second Quarter, Third Quarter, Fourth Quarter
• First, Second, Third, etc. 
• 31-Dec-96
• 31-Dec
• Dec-96
• 31/12/96 or 12/31/96
• 31/12 or 12/31

Filling a selection using two cell values
You can use the interval between two cell values to calculate the values for the selection. For example, if you enter 1 
in the first cell, and 3 in the second cell, the remaining selected cells will be filled in as 5, 7, and 9. Negative numbers 
appear if the second number is smaller than the first. 

{button ,AL(`H_LC_FILL_BY_EX_STEPS',1)} Go to procedure



Entering data using Fill by Example
1. Choose Chart - Edit Data.
2. Click a cell to select it, then drag to select the other cells you want to fill.

The values in the selection are based on the first or first two cell values. See details.
3. Click Fill by Example.

{button ,AL(`H_LC_FILL_BY_EX_DETAILS',1)} See details
{button ,AL(`H_LC_MODIFYING_CHART_DATA_STEPS;H_LC_ADDING_DATA_TYPING_STEPS;H_LC_LINKING_

DATA_STEPS;H_LC_CREATING_FROM_CLIPBOARD_STEPS;H_LC_EDITING_TEXT_STEPS;',0)} See related 
topics



Working with charts
You can get Help about working with charts. Do one of the following:

• Choose Help - Help Topics to open the Help Topics box.
• Click the Help button in a dialog box to get help for the dialog box.
• Click the question mark (?) in the upper-right corner of the InfoBox.
• Press F1.

To locate a topic in the Help Topics box, do one of the following:
• Click the Contents tab. Double-click the "How Do I?" book. Choose "Work with Charts."
• Click the Index tab. Type a topic or scroll through the list of topics. Click a topic, then click the Display button.



Details: Labeling radar chart axes
When you want to change the display of the radar axes, choose Chart - Axes to open the InfoBox to the appropriate 
tabs. Click the tab that corresponds to the part of the axes that you want to modify.

Using independent axes
You can specify independent axes for radar charts using the InfoBox. Choose Chart - Axes to open the InfoBox. Click 
the Ticks, Labels, or Scale tab, then check the box labeled Make axes independent. A drop-down list of the axes 
appears. Once you select an axis, you can display tick marks (Ticks tab), show labels at a specified interval (Labels 
tab), or manually set the scale (Scale tab).

{button ,AL(`H_LC_LABEL_RADAR_AXES_STEPS',1)} Go to procedure



Setting axis titles and ticks in charts
Use the Titles, Ticks and Labels panels with the selected x-axis, y-axis, or z-axis.

Choose a task
Adding axis titles and subtitles 
Changing the axis scale 
Displaying axis labels 
Using the InfoBox with charts 



Setting axes scale properties for charts
Use the Scale panel to change the scale of the selected axis.

Choose a task
Changing the axis scale 
Changing the intersection of the axes 
Using the InfoBox with charts 



Setting 3D properties for charts
Use the 3D panel to change the look of 3D settings in a chart.

Choose a task
Changing 3D for area, bar, line, and mixed charts
Changing 3D for pie charts
Using the InfoBox with charts 



Setting the range properties for charts
Use this tab to change the Range properties.

Choose a task



Setting grid properties in charts
Use the Grids panel to set the grid lines for x-axis, y-axis, and z-axis of a chart.

Choose a task
Adding grid lines and tick marks 
Using the InfoBox with charts 



Setting options properties for charts
Use the Options panel to control the display, content, and position of chart parts such as series, titles, and pie labels. 
The Options panel changes to reflect the current selection. For instance, if you select a pie chart, the options will refer
to pie charts.

Choose a task
Hiding and showing parts of a chart 
Adding a note to a chart 
Adding titles to a chart 
Using the InfoBox with charts 

Choose a task for bar and area charts
Plotting a series against a 2nd y-axis 
Changing to a different chart type 
Adding a table below a chart 

Choose a task for pie charts
Showing pie titles and totals 
Displaying pie slice labels 



Setting chart types
Use the Type panel to change the chart type, and to specify whether it is a 2D, 3D, or "with depth" chart.

Choose a task
Changing to a different chart type 
Using the InfoBox with charts 



Setting text properties for charts
Use the Text panel to change the Font name, size, and style for any selected chart text.

Choose a task
Changing text fonts, sizes, and colors
Using the InfoBox with charts 



Setting legend properties in charts
Use the Options panel to hide, show, or reposition the chart legend.

Choose a task
Hiding and showing parts of a chart 
Selecting chart parts using the InfoBox 
Using the InfoBox with charts 



Setting lines and colors properties in charts
Use the Lines & Fill panel to change the line, color, and fill of the chart part you select, such as a series, title, and 
legend.

Choose a task
Changing line styles in a chart
Changing colors and patterns in a chart
Using the InfoBox with charts 



Setting options for a note in charts
Use the Options panel to create, display, or reposition a note of explanatory text for the chart. In an XY (scatter) chart,
you can display regression line information as a note.

Choose a task
Adding a note to a chart 
Editing chart text 
Adding a trend line to a chart 



Setting number properties for charts
Use the Number Format panel to change the style of numbers in series, slice labels, and pie totals that you select.

Choose a task
Changing numeric formats
Using the InfoBox with charts 



Setting slice properties for pie charts
Use the Layout panel to explode pie slices, change the pie slice direction and start angle, and sort the pie slices by 
size.

Choose a task
Exploding pie slices 
Changing the start angle and direction for pie charts 
Sorting pie slices by size 
Combining pie slices 
Using the InfoBox with charts 



Setting layout properties for pie charts
Use the Options panel to hide or show, or to reposition the value labels, percent labels, or slice labels when you have 
Pie Slices selected. 

Choose a task
Displaying pie slice labels 
Using the InfoBox with charts 



Setting platform settings for charts
Use the Plot Section of the Lines & Colors tab to select and modify the platform area for a 3D chart.

Choose a task
Changing the 3D platform 
Using the InfoBox with charts 



Setting layout properties for charts
Use the Layout panel to change plot settings in the bar, area, and line chart that is selected.

Choose a task
Stacking and overlapping chart series
Changing the spacing between series 
Using the InfoBox with charts 



Setting properties for chart series
Use the Options panel to change the settings for the selected series. The options vary depending on the chart type 
you have selected.

Choose a task
Hiding and showing parts of a chart
Plotting a series against a 2nd y-axis 
Using the InfoBox with charts 



Setting picture properties for charts
Use the Pictures panel to add pictures, remove pictures, and change the picture size when you have a bar series 
selected.

Choose a task 
Showing pictures instead of bars in a bar chart 
Using the InfoBox with charts 



Setting series trend properties in charts
Use the Series trend panel to add or change a trend line for the selected scatter (X,Y) plot series.

Choose a task
Adding a trend line to a chart 
Using the InfoBox with charts 



Setting properties for series labels in charts
Use the Options panel to display or reposition the value labels or percent labels for the selected series.

Choose a task
Displaying chart series labels 
Rotating chart series labels    
Using the InfoBox with charts 



Setting table properties for charts
Use the Options panel to display the data table under the chart, and to change the table settings. 

Choose a task
Adding a table below a chart 
Displaying row and column headers in a table or number grid 
Using the InfoBox with charts 



Setting title properties for charts
Use the Options panel to enter title text, hide or show a title, or reposition the title when it is selected.

Choose a task
Adding titles to a chart 
Editing chart text
Moving a chart part 
Using the InfoBox with charts 



Using the InfoBox with charts
Use the InfoBox to change properties and settings for the chart part you select.

To open the InfoBox
1. Do one of the following:

• Choose Chart - Chart Properties. The InfoBox opens to the panels that apply to the entire chart.
• Choose Chart, then a chart part from the menu(such as Legend, Plot, or Series.) The InfoBox opens to the 

panels that apply to the selected chart part.
• Double-click a chart part. The InfoBox opens to the panels that apply to the selected chart part.

2. Click the tab for the panel you want to use.

To display the appropriate panel
The tabs and panels will change depending on the current selection in the chart.
1. Under Properties for, select the name of a chart part. 
2. Click the tab for the panel you want to use.
Tip To change the chart selection, select a different chart part from the "Properties for " list at the top of the InfoBox.



Setting layout properties for pie chart slices
Use the Layout panel to explode pie slices, change the pie slice direction and start angle, and sort the pie slices by 
size.

Choose a task
Exploding pie slices 
Changing the start angle and direction for pie charts 
Sorting pie slices by size 
Combining pie slices 
Using the InfoBox with charts 




